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1 Introduction

Dear Customer,

Welcome to Voltcraft®. Thank you for purchasing this product and we are sure you have made
a very good decision.

Voltcraft® - in the field of measuring, charging and network technology, this name represents
high quality products which perform superbly and which are created by experts employing
continuous innovation and improvement. From ambitious hobby electronics enthusiast to
professional user, products from Voltcraft® brand family provide the optimum solution even
for the most demanding tasks. Voltcraft® products also offer an almost unbeatable price-
performance ratio. This is why we are absolutely certain: With our Voltcraft® product line, we
have created the foundation for a long, prosperous and successful customer partnership.

We wish you have a great deal of enjoyment from your new Voltcraft® product!
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2 Using this Manual

The Voltsoft System (Voltsoft) is integrated control software for controlling different Voltcraft®
electronic products. By using Voltsoft, you can manage your Voltcraft® products using only a
single piece of software.

This manual will explain the usage and workflow of different components of Voltsoft, and also
discuss how Voltsoft can control different hardware models.

There are many terms and abbreviations in this manual that may be unfamiliar to you if you
are new to web hosting. You can find information on these terms and abbreviations in the
glossary of this manual or by searching them using an Internet search engine such as Google.
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3 Installation

3.1 System Requirements

To install Voltsoft, your computer should contain:
- Pentium 233-megahertz (MHz) processor or faster
- At least 1GB of RAM
- At least 2GB of available space on the hard disk
- USB 2.0/ 3.0 Port(s)

Voltsoft only supports the following operating systems:
- Microsoft Windows XP Service Pack 2 or above
- Microsoft Windows Vista Service Pack 2 or above
- Microsoft Windows 7

If your Windows does not contain the corresponding service pack version, please perform a
Windows update first.

.NET framework library version:
- .NET framework 2.0 SP2

If your Windows does not contain the corresponding .NET framework, Voltsoft setup will help
you to download it from the Internet. However, it is recommended upgrading first before
installation.

Some device may not work if connecting via USB Hubs, included:
- DL101T / DL121TH / DL161S / DL180THP / DL111K
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3.2 Install Voltsoft

1. Insert the installation CD-ROM in your drive.
2. The menu will be opened automatically (if installation doesnt start, double-click
autorun.exe in your CD-ROM directory). Follow the on-screen instructions.

Step 1: Select the installation language

Select Setup Language @
Select the language to use duting the installation:

e X
Welcome to the Voltcraft -

Voltsoft System Setup Wizard

Thig will inztall Volkcraft - Vaoltzoft System Yerzion 1.0 an pour
computer.

It iz recommended that pou cloze all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

[ Meut> |[ Cancel
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Step 3: Select Destination Location

\/|Setup - Yoltcraft - Yoltsoft System

Select Destination Location
where should Valteraft - Valtzaft Systern be installed?

D Setup will inztall Wolkcraft - Waoltzoft Syztem into the follawing falder.

To continue, click Mext. If you would lke to select a different folder, click Browsze.

I:Z:"-.F'n:u:uarn Files'y | [ Browse. .

At least 675 MB of free disk space is required.

’ < Back ” Mext » ][ Cancel

Step 4: Tick the checkbox to create desktop icon for Voltsoft

\/|Setup - Voltcraft - Voltsoft System

Select Additional Tasks
Ww'hich additional tazks should be performed?

Select the additional tagks you would like Setup to perform while installing Woltcraft -
Yaltsoft System, then click Mext.

Additional icons:

< Back ” Ment » ][ Cancel
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Step 5: Click “Install”. Installation will begin.

\/|Setup - Yoltcraft - Voltsoft System

Ready to Install ~ )
Setup iz now ready to begin inztalling YWoltcraft - Woltzoft Spstern on your computer. G
Click Inztall to continue with the installation, ar click Back if you want to review or
change ahy zettings.
Destination location:
C:\Program FilestWoltzoft
Additional tasks:
Additional icons:
Create a desktop icon
< Back ]| Install  § [ Cancel ]

\/ Setup, - Voltcraft - Voltsoft System

Installing " J
Fleaze wait while Setup installs Yoltcraft - Waolksaft System on your computer. =

Extracting files...
C:%Program FilestWoltzoft\\W'eb Server\Devicew'eb\binhSystem D ata SCLite.dl

. Cancel




Voltsoft User Manual Version 2.0

Step 6: Click “Finish” to complete the installation

'\/|Setup, - Volicraft - Yoltsoft System g|§|g|

Completing the Voltcraft - Voltsoft
System Setup Wizard

Setup has finished installing Volkcraft - WValkzoft Spstemn an vour
camputer, The application may be launched by zelecting the
installed icons.

Click Finizh to exit Setup.

Finizh
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3.3 Register Voltsoft

Voltsoft has two different versions:

Standard and Professional.

contains more features than the standard edition.

Standard vs. Professional

The professional version

Standard Professional
User Management
Email Management
General Settings v
Language Preference Vv

Email Template

Device Management (Add / Remove)

Custom Graph

Email Alert

Web Interface

SRR KK

Voltsoft will be installed by default as the standard version. In order to enable the professional
features, you have to purchase a software package (VoltSoft Data Logger, BN: 101333) and

enter a valid license key (which is attached on CD) to register.

To register:

1. Launch the Voltsoft Windows client

\/ [ VOLTCRAFT - Valtsoft

EEX

File  Device Management  Help

10
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2.

Nowun

Click Help -> Online Activation

\/ Online Activation |Z||§| E|

Please input Activation Key to unlock all system features

License Key |XXXK-XXXK-XXXK-XXKK

Registration

Company® |Compan\;A

Department | Departrment A

Salutation” & Title  Mr. ||

Street, Mo.® | Street 1

|
|
|
First Mame* & LastMame® | John || Smith |
|
|

Postcode™ & city™ | 00000 | [citya
Courtry™ | HOLY SEE (VATICAN CITY STATE) v
Phone* 01234567 | (e, 01234567)
Faxno. | | (2.9 01234567)
Mohile Phone | | te.s. 012345867)

Email* johnsmith@abe com |

*Required Field

[ Use Proxy Sermer
Address FPart l:l

[] I have read and acceptta the privacy palicy and license agreement

Frivacy policy and license agreement

[ Activate ] [ Cloge

Enter a valid license key and the registration information.

Enter the proxy server settings if your computer accesses the Internet through a proxy
server.

Please read and accept our privacy policy and license agreement.

Click the “Activate” button to perform online activation.

If activation is successful the following message will be displayed:

Volisoft f5__<|

Activation Success

11
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4 Standard Version

4.1 Launch the Voltsoft Windows Client

To start the application, please go to Start Menu -> All Programs -> Voltcraft -> Voltsoft Client

Main screen of the Voltsoft client is as follows:

\/ YOLTCRAFT - Yoltsoft =13

File  Device Management  Help

VOLTCRAFT.

“SL451-400 ' DL101T - Logger 1 - X

Device  Graph

T — Data y Graph \ 3

————— DL101T - Logger 1

aa

25 +

Temperature(°C)
o

o | - - | - | : - |
06:50:32 06:50:47 06:51:02 08:51:17
04-05-2011 04-05-2011 04-05-2011 04-05-2011
Time: 04-05-2011 06:51:05 Temp.:28.8(°C)

1 Main Menu Area Users can access different functions through the main
menu.

2 Device List Area Contains the list of devices which are already registered in
the system.

Green icon - Indicates that the device is currently
connected to the computer
Red icon - Indicates that the device is currently not
available.
Clicking on the icon can open that device in the device
control panel area.

3 Device Control Panel The opened device will be displayed in this area.

12
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4.2 General Settings

To launch this module, please click File->Settings.

|/ General Settings

IInit Preference

Temperature Celsius

Air Pressure hPa

Drata Storage
Remaove records after |60 5 | Dawis)
ownload Lata
[] Owenwrite data with duplicate download time 3
Emal =ethings
Email Sender | no-reply@cei.com 4
SMTP Server smitp.hkhn.net Faort |25
Lagin 1D Passward
[ ] Enable S5L
Web Serer Setting
5
Maximum Mumber of Login - |2 &
Welcame message | YWelcome message
Fort Mumber an
LIRL hitp:192 168.1.130f
6 [ Restart Yaoltzoft Server ] [ Save ] [ Cloze l
1 Unit Preference Select the measurement unit used in Voltsoft.
2 Data Storage In order to prevent data overload, the system will delete

old data automatically. User can specify the number of days
to keep the device readings.

3 Download Data If this option was checked and the system is downloading
new data with measurement time, which already existed in
the database, then existing data will be overwritten.

4 Email Settings This area configures the outgoing email settings.

Email Sender - This will be the email sender of the alert
email.

SMTP Server and Port — The outgoing SMTP server name
and port number. (for Gmail, port number is 465)

Login ID and Password — The SMTP server login and
password (if required).

Enable SSL - Check this checkbox if your SMTP server
requires SSL encryption (i.e. Gmail)

13
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This setting is available in the professional version only.
5 Web Server Setting Configure the web server port number for the web-based
version of Voltsoft.

The local IP address will also be displayed, however, if you
have more then one network card, then only the first IP
address detected will be shown here.

The maximum number of logins controls the maximum
number of concurrent logins.

6 Restart Voltsoft Restart the Voltsoft Server.
Server
Save Save and quit this module.
Close Quit this module without saving.

14
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4.3 Add New Device

This module should automatically pop up when the user plugs a new device into the computer.

Device Management System

Mew device detected, do vou want bo add it inko the syskem now?

\/ Add New Device

Device Series |Data Logger v| 1
Model Nurber  DL121TH v
Alias Logaer 121 |
2 3 4
[ Auto-Detect ]I[ Add l|| Cloze ]l

1 Select Device To add a new device:
1. Select the device series (only Data Logger available in
the current version).
2. Select model number.
3. Enter a unique alias.

2 Auto-detect Click this button to let the system detect if there is any
device connected but not yet registered.

3 Add Click the Add button to confirm the addition.

4 Close Click the Close button to close this module.

15
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4.4 Remove Existing Device

This module allows the user to remove devices which are no longer in use. To launch this
module, click Device Management->Remove Existing Device.

\/ Remove Existing Device E“E|E|

CATALOGGER - DL141TH - 140
DATALOGGER - DL141TH - 140-2
DATALOGGER - 51451 - 400
DATALOGGER - DL1MT - Logger 1
DMM -%C330 - 330

DM -%C350 - 950

Remove All ][ Remove ][ Cloze

To remove a device, click the device in the list and click the “Remove” button.
Click "Remove All” button to remove all devices at the same time.

16
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4.5 Device Control Panel

The opened device will be displayed in the device control panel area in tab format. Each tab

will contain information for one single device.

5L451 - 400 ) DL101T - Logger 1 |

Device  Graph I1
/ Data _— Graph 3
DL101T - Logger 1
[ > Temperature |
30 . - T T T
25 1
20 +
3}
2.
h
3
E 159 +
o
o
E
o
'—
10 +
5 4
I _ ' ' f ' I ¢ ' f
06:50:32 06:50:47 06:51:02 06:51:17
04-05-2011 04-05-2011 04-05-2011 04-05-2011
Time: 04-05-2011 06:51:05 Temp.:28.8(°C)

Each device tab contains:

1 Device Menu Area Each device will contain its own menu, which will be
explained in an upcoming section.

2 Data Tab Display the selected data in list form.

3 Graph Tab Display the selected data in a graphical format.

The function of the modules may be different for different devices, therefore, they will be

discussed in individual device section.

17
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5 Professional Version

All features of the standard version and some advanced features are included in the
professional version. The following features will be available after online activation of the
professional version.

5.1 User Management

To launch the user management module, click on File->User Management on the main menu.
The user management of this module is only for the web-based version.

\/ User Management E”E'E'

The following uzer(z] will be available for web only.

Login Mame |

Loqin Harne Full Hame

admir Adminiztrator S—
Pazzword

HHHHHH

Confirm Pazsword

Full Mame |.-5'-.|:|ministrat|:|r

Ex=piny Date |

Active {(*) ves () Mo

[ T |
s

|lzer b anagement

Select the device if you want to hide it from that user.

] 1m
112
114
] 181

] 180
[ 4000

1 User List Display the list of users in Voltsoft.
2 User Details Clicking on the user name will display the user’s details in
this area. Users can:
- Modify their password
- Assign an expiry date for that user
- Modify the active status for that user.

3 User Privileges Control whether the user can access the user management
module or not in the web-based version.
4 Device List Control which devices are available for the selected user in
the web-based version.
Delete Click on a user in the user list and then the Delete button to
5 delete an existing user.
Add Click on the Add button to create a new user.
Save Save the current user’s information.
Close Close this module.

N.B. Voltsoft only allowed max. three user exist in the system.

18
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5.2 Email Management

This module allows the user to manage the email addresses of those who will receive email
alerts. To launch this module, click File->Email Management in the main menu.

\/ Email Management E“E|@

Following email will receive email alert when device
reading reach cerntain alert level

E rnail Addrezs 1

jahnzmitiedgrail. com

|iuhnsmit@gmail.mm |
| |

2 [ Add Femove 3] | Cloze 4
1 Email Address The email address is configured within Voltsoft.
2 Add New Email Input a new email address and click the Add button to add
a new email into the system.
3 Remove Email Click on an email in the email address list and click the
Remove button to remove the email from the system.
4 Close Close this module.

19
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5.3 Email Template

To launch this module, click Preference->Email Template.

|/ Email Template

Language | Englizh

Subject |'\-"u|tsu3fl Drata Alert

b aimnurn Alert Dear Sir/Madam,

The device {DEYICE} has reached the max. alert level on column {COLUMMY at {TIME}, cunent reading walue
{READIMNG}

Pleasze perform amy necessary action,

Regards,
Yolsoft

binimum Alert Dear Sir/Madam,

The device {DEVICE} has reached the min. alert level on column (COLUMN} at {TIME}, cument reading value
{READING}

Pleaze perform any necessary action.

Fegards,
olkzoft

Dear Sir/Madam,

The device {DEYICE} reached alert level but had been reset on column {COLUMM} at {TIME}, curent reading
valug {READING}

Pleaze perform any necezgary action.

Regards,
Woltzoft

1 Language Select the language of the email template.
2 Message Content Fill in the title and content for the email template which will
be sent in the different cases:

Case 1: Maximum Alert
This email will be sent when a reading is higher than the
maximum alarm level.

Case 2: Minimum Alert
This email will be sent when a reading is lower than the
minimum alarm level.

Case 3: Reset Level
This email will be sent when a reading was previously at a
max/min alarm level but has returned to a normal level.

3 Save Click the Save button to save the template.
4 Close Click the Close button to close the module.

20
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Variable

The following labels are defined as variables and will be replaced when sending out.

1 {DEVICE} The device alias

2 {COLUMN} The device reading name

3 {READING} The device reading value

4 {TIME} The time the event happened

5.4 Email Alert
\/ Email Alert |Z| |§|E|

Recipient(z] Lzt

Following receipient[z] will receive email alert

johrzmitiigmail. com

ok || Ciose

Voltsoft has an email alert feature, which will send out an email to the specified user when the

device reading is above or below a certain level.

The user can use this module to select who will receive the email for the specific device.

21
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5.5 Custom Graph

Custom Graph allows the user to graph the measurement readings from more than one device.
To create a custom graph:

1. Select Device Management->Custom Graph in main menu.

\/ Custom Graph

Exist Graph | [N

2. Select New to create a new graph or select the previous saved graph. Click OK to
continue.

3. The Custom Graph detailed interface will be displayed:

"\/ Custom Graph

Graph Mame |I3ra|:|h 1

Device and Measurement

Data Period PC storage range E arliest data; 04-05-2011 08:50:37 Latest data:  04-05-2011 06:51:23

From: |1306201 0000 v | Ta 140520112353 v | [ Real Time Data

Device Measurement
DLIO1T - Logger 1

Selected Measurement
950 - Yoltage [ DC)

OL141TH - 140
DL141TH - 140-2
Y930 - 930
%980 - 950
Mext Step > ] [ Save ] [ Firizh ] [ Cloze

22
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4. Then the user needs to:

I. Select the data period or real-time data (only specific devices support real-time
reading).

II. Select the device and measurement column.
ITI. Click Next Step> to continue.

\/ Custom Graph E|E|®

Graph Mame |Graph 1 |

M eazurement Setting

Selected Measurement

Device Measurement D ata b ax. Data Min. Lz iz Max. Az Min. Align Zero
350 oltage [+ D) 1 I ¥ - -

140 Temperature i} i A - = M

140 Deve Point 1} 1] 1 - - M

mis @yt Ovz  misax | sdstin | | coou [ O #ionzeo
’ < Prev Step ] [ Save ] [ Firizh ] ’ Cloge ]

IV. For each column, the system will show the data maximum and minimum values
for the selected period.

V. For each column, the user can specify whether it is drawn in Y1 or Y2, specify the
Y-axis maximum and minimum values, the corresponding colour of the line or
align the Zero level to the same level or not.

VI. Click Finish to generate the graph.

Data / Groph \
Graph 1
— [Logger 100] Temperature —  [Logger 120] Temperature — [Logger 160] Relative Humidity [Cogger 180] Air Pressure
[Logger 160] Sound Level dBC [Logger 400] Sound Level dBA [Logger 120] Dew Point
504 35 =

30

40
25 4

I
5

g
1% g 20
5 T
£ E]
g
E- B
© 2
3 5 5
1% 8 15
& 20
10
10
5 |
ol o ; ; ¢ +
2153 22:08 22:23 2238 2253 2308

From:11-10-2010 22:00:00 To:11-10-2010 23:00:59
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5.6 Web Interface
5.6.1 Using the Voltsoft System (Web)

Voltsoft also provides a web-based interface for the user to control the device through Internet
Explorer (version 7 or 8).

To access the Voltsoft Web interface, please open Internet Explorer (I.E.) on your local
computer and input http://127.0.0.1 or http://localhost. If you change the port number in
General Settings to another port number, then you are required to enter the port number too,
e.g. http://127.0.0.1:8080.

If it is successful the login page will be displayed.

/= YOLTCRAFT - Device Management System - Windows Internet Explorer |:”E”zl

G—e ~ | repyiter.o.0.y v||£||z| |ve search ||EZ\

S »
1% hr JEWOLTCRAFT - Device Management System l l @ = @ = @Eage v @Tgols o

Cione °Internat #100% - _I

Enter the valid user login created in the user management module.

24
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After login, you will see a main screen similar to the Windows client.

{= YOLTCRAET - Device Management System - Windows Internet Explorer |Z||E|E‘
@dm/ ] http:ji127.0.0.tjindex. asprt >[4 [x] | |[2]-

W [@\fOLTCRAFT-Device Management System l_l - B & - [Erege - BTk
File Device Management Logout

VOLTCRAFT.

© DL-100T - Logger 100

& DL-120TH - Lagger 120
© DL-140TH - Logger 140
© DL-1605 - Logger 160

&) DL-180THP - Logger 180

(& 5L-400 - Logger 400

Done

0 Internet "‘ 100% -

Click on the device entry and you will be prompted to install an ActiveX control issued by CEI
Conrad Electronic International (HK) Ltd. Please click Install to install it.

Internet Explorer - Security Warning

Do you want to install this software?

Mame: DeviceWebChark,cab

Fublisher: CEI Conrad Electronic International (HKY Lid.

More options | Install

Don't Install

‘While Files From the Inkernet can be useful, this file bype can potentially harm
wour compuker, Only install software from publishers wou trust, What's the risks

After the installation, the chart control should be displayed like this:

25
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DL-100T - Logger 100

(& DL-100T - Logger 100
© DL-120TH - Logger 120
DL-100T - Logger 100

© DL-140TH - Logger 140
© DL-1605 - Legger 160 12 T T T
© DL-180THP - Logger 180
© SL-400 - Logger 400 104

~ 0.8 4

)

<

£

=

® 06

a

o

£

o

=04

024
0o t t t t t
(0&:00:00 12:00:00 18:00:00 00:00:00 06:00:00
01-11-2010 01-11-2010 01-11-2010 02-11-2010 02-11-2010
Time:01-11-2010 14:34:43
K| Lol
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5.6.2 Accessing Voltsoft Web from a Remote Computer

Voltsoft Web allows users to control the device information from a remote computer through
I.E., just like the remote feature of the IP camera. However, the computer may need some
configuration changes in order to allow access to incoming traffic.

1. First, you need to check the IP address of your computer by opening the settings page in
the Windows client or check by using command prompt.

To check by using command prompt, open a command prompt and enter ‘ipconfig’.
et C:AWINDOWSsystem32emd. exe

C:w>ipconfig

Windows I[P Configuration

Ethernet adapter Local Area Connection 3:

Connection—specific DHNES Suffix

IP Address. . - . - & & =« & = - - = 192.168.1.138
Subnet Maszk - 255.255.255.08
Default Gateway 192 168.1.1

For example, your IP address is 192.168.1.130 in the above example.

2. Secondly, check your firewall settings. Go to Control Panel, and click on Windows Firewall.

27
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"= Windows Firewall

General | Exceptions | &dvanced

Windowsz Firewall helps protect pour computer by preventing unauthonized users
from gaining access ba wour computer through the Internet or a netwark.

@ O On [recommended)

This zetting blocks all outside sources from connecting to this
computer, with the exception of thoze selected on the Exceptions tab.

Select this when you connect to public networks in less secure
locations, such ag airports, You will not be notified when Windows
Firewall blocks programe. Selections on the Exceptions tab will be
ignored.

@ (=)0ff [not recommended}

Awaid uzing this setting. Turning off *Windows Firewall ray make this
caomputer more vulherable to viruzes and intruders.

Wwhat else should | know about Windows Firewsll?

I 0K ][ Cancel ]

3. For testing, you can turn off your firewall. Or you can also configure the firewall by
allowing an exception. For details, please contact your network administrator.

4. Then you can try to access the Voltsoft Web through another computer on the same
network. E.g. in the above case, you should input http://192.168.1.130 in I.E. If you have
any problems, please contact your network administrator to check the network
connectivity between the two computers.

5. You may access Voltsoft Web through the Internet from a remote site office, however you
will be required to provide the network settings of your computer to your network
administrator in order for him/her to configure your company router and firewall.

28
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5.6.3 Using the Voltsoft System (Web)

The interface of the Web client will be very similar to the Windows-based client.

i. Login Screen

English

29
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. Main Screen

File [Dewice Management Layout Logout |
© DL141TH - 140 Peuf @il —
. Dt ]I Graph
&' DL141TH - 140-2 ¥
o PC storage range Earliest data: 04-05-2011 06:50:37 Latest data: 04-05-2011 08:51:23 —
ol T ———————
) DL1DIT - Logger1 Measurement Maimum alue MinimLm alue Average Value
Temperature (°C) 288 285 288
All Data L Expaort CSY ] [ Export Excel
Record Time Tempersture (*C) ~
04-05-2011 06:50:37 288
04-05-2011 06:50:39 288
04-05-2011 06:50:41 288
04-05-2011 06:50:43 288
04-05-2011 06:50:45 288
04-05-2011 06:50:47 288
04-05-2011 06:50:49 288
04-05-2011 06:50:51 288
04-05-2011 06:50:53 288 U= |
04-05-2011 06:50:53 285
04-05-2011 06:50:57 288
04-05-2011 06:50:59 288 )
04-05-2011 06:51:01 285
04-05-2011 06:51:03 288 B
04-05-2011 06:51:05 288 w
— | o
I J Trusted sites G v 0w -
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Screen Layout

One of the most significant differences between the Windows version and the Web version is
that you can arrange the Web version’s device windows into three different layouts: 1) Single
Column, 2) Two Columns, 3) Tab Layout

1) Single Column

File Device Management Layout Logout

Device Graph

& DL14ITH - 140

Data l ph |

(©) DLL4LTH - 140-2
DL101T - Logger 1

& sLas1- 400
.
& DL10IT - Logger 1 30 T T

25 4

20

Temperature(*C)
o

5 4
0 } } }
08:50:32 DB:50:47 0B:51:02 06:51:17
04-05-2011 04-05-2011 04-05-2011 04-05-2011
Time
Kl i
< &3

Devica  Graph

Data | ph |

| SL451 - 400 |
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2) Two Columns

© DLLAITH - 140

© DLL4ITH - 140-2

PC storage range
@ sL4s1- 400

(2 DLL0IT - Logger 1

Record Time

04-05-2011 D6:50:37
04-05-2011 DE:50:39
04-05-2011 05:50:41
04-05-2011 06:50:43
04-05-2011 06:50:45
04-05-2011 DG:50:47
04-05-2011 DE:50:48
04-05-2011 DE:50:51
04-05-2011 08:50:53
04-05-2011 06:50:55
04-05-2011 06:50:57
04-05-2011 D6:50:58
04-05-2011 DE:51:0
04-05-2011 08:51.03
04-05-2011 06:51:05
04-05-2011 06:51:07
04-05-2011 D6:51:08
04-05-2011 DE:51:11
04.05-2011 DE:51:13

Earliest data: 04-05-2011 06:50:37

Tempersture (°C)
ﬁB 8
288

1288
288
288

1288

1288
288

1283
288

1288

1288
288

1288

1288
288
288
288
288

Latest data: 04-05-2011
065123

[ Export C3Y ] [Expnn Excel ]

TEwThe,

SL451 - 400

o8

08

Sound Level

04

02

o0

4501
16-06.

0:00
2011

21:00:00
18-08-2011

02:00:00

03:00:00 15:00:00
17-08-2011 17-08-2011 17-06-2011
Tirwe

i

@ DL121TH -121

© DL14ITH - 141

PC storage range
© DpLisIs- 161
© siasi- 41 Real Time Mode

@ sLasi- 4512
Record
Time

© sLasi- 451-3

201

05:12:48

229
@ vicazo - 930

© veasn - ves

°C Temp

Earliest data: 13-07-2011 05:55:15

Reading Unit Function Macle

Latest data: Current Time:

] 0

rm
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2) Tab Layout

File

Data Lagger

© DL14ITH - 140
© DL14ITH - 140-2
© sLas1- 200

@ DLINIT - Logger 1

DMM

Device Managemeant Layout Logaut

DLADIT- Loguend & SL451- 400 =

VOLTCRAFT

Data Graph

Temperature(°C)
o
=

o
N
L

o
=
L

0.0

DL101T - Logger 1

158:00:00 21:00:00
16-06-2011 16-06-2011

03:00:00
17-06-2011

Time

09:00:00
17-06-2011

15:00:00
17-06-2011

Dl

5.6.4 Limitation in Web Version

Although the interface and function of the Web version is very similar to the Windows version,
they have some differences as following:

1) The Web version is targeted to those users who are not in front of the computer which is

connected to the device; therefore, the "Add and Remove Device” function will not be available
in the Web version.

2) The Web version will not auto refreshed in some areas (when compared with the Windows

version), so users are required to press “F5” or the “"Refresh” button in the browser tool bar on
the interface. These areas are:

i Device list

ii. Real-time / Display status for VC930 or VC950
iii. Real-time / Display status for VC850 or VC650BT
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6 Supported Devices

Voltsoft currently support following devise:

Type Device Name
Data Logger DL101T

Data Logger DL111K

Data Logger DL121TH

Data Logger DL141TH

Data Logger DL161S

Data Logger DL181THP
Data Logger SL451

DMM

VC930 / VC950

DMM VC880 / VC650BT
DMM VC890
EL4000 EL4000
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6.1 DL101T

DL101T is a data logger for storing temperature reading.

6.1.1 Add new DL101T
When Voltsoft detects a new DL101T attached, the following dialog will be popped up:

Device Management System

Mew device detected, do vou want bo add it inko the syskem now?

Click “Yes”, the following dialog will be displayed:

\/ idd New Device

Device Series |Data Logger

Model Number | DL101T

Alias 101T]

[.ﬁ.utn-Detect ] [ Add l [

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.1.2 Remove DL101T

To remove DL101T, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.1.3 DL101T - Device Control Panel
A DL10AT - 101 - M
Device  Graph
IJ‘ D ata \ Graph |
PC ztorage range Earliest data:  09-01-2013 22-42:27 Latest data:  10-01-2013 16:29:03
2 Surmrmary
Meazurement Maximum “Yalue Minimurm %'alue Average Value
Temperature [*C)
All Data Export Excel ] [ Expart C5Y
Record Time Temperature (*C)

The DL101T Device Control Panel contains follow items in menu:

1 Device -> Settings

2 Device -> Download Data

3 Device -> Display / Plot Data
4 Graph -> Plot Colour

5 Graph -> Background Colour
6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11  Graph -> Zoom Out
12  Graph -> Zoom To Fit

This will launch the setting page of DL101T.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.1.4 DL101T - Settings

\/101T - Settings (HW ID:01_1210170003)

Basic Settings

1 Time Use System Time
Logger Mame mT
Record Start Condition ) By Button (5) After Setup
=ample Paints 32000 b sample Hate | 2s b
Recarding Time 17 Hours 46 Minutes 40 Seconds
LED Flash Cycle ® 103 O 20s O 30s

Alarm Settings
[ ] Enable LED=s Alert

Temperature Lo Limit 0.0 50 2 High Limit /00 ) "G

b, |

Device connect,

Drefault ] [ Setup ] [ Cloze

1 Time Configure the device data time value.
The user can specify a defined time or use the system
date time.

2 Logger Name Input the unique alias for that device.

3 Record Start Condition By Button - The data logger will start recording only
after the user pressed the red button on the device.
After Setup - The data logger will start recording
immediately after setup.

4 Sample Points Instruct the logger to take a finite humber of readings.

5 Sample Rate Instruct the logger to log readings at a specific rate.

6 Recording Time Calculate the recording time based on the selected
sample points and sample rate.

7 LED Flash Cycle Configure the LED flash cycle - the longer the time, the
longer the battery life.

8 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

9 Temperature Low / High Configure the temperature low / high alarm level.

Alarm

10  Default Button Reload the factory default settings.

11 | Setup Button Save changes.

12 | Close Button Close this interface.

Note: Any stored data will be permanently erased when setup is finished.
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6.1.5 DL101T - Download Data

This module allows user to download the data from DL101T.

Download Data

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recarding.

Device connect. ] l ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.1.6 DL101T - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Plot D ata
() PC storage range Earliest data: WA, Latest data; MA&

) From: 09-12-2012 16:22:24 b Tao: 10122012 17:22:34 v

Device connect.

[ ok || cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.1.7 DL101T — Data View

DL101T contains one measurement (Temperature) only, its unit can be Celsius or Fahrenheit,
depending on the setting in general setting.

Device  Graph

PC storage range Earliest data: 01-11-2012 16:28:13 Latest data:  02-11-2012 01:31:29

% Summary

All Data Erpoart Excel ] [ Expart C5Y

Record Time Temperature (*C) ~

01-11-2012 16:56:03 254

01-11-2012 16:56:05 254

01-11-2012 16:56:07 254

01-11-2012 16:56:09 254

0M-11-2012 16:56:11 254

01-11-2012 16:36:13 254

01-11-2012 16:56:15 254

01-11-2012 16:56:17 254

01-11-2012 16:56:19 254

01-11-2012 16:56: 21 254

01-11-2012 16:36:23 254

01-11-2012 16:36:25 254

01-11-201 2 16:56:27 254

01-11-2012 16:56:29 254

01-11-2012 16:56:31 254

01-11-2012 16:56:33 254

01-11-2012 16:56:35 254

01-11-201 2 16:36:37 254

01-11-2012 16:36:39 254

01-11-2012 16:56:41 254

01-11-2012 16:56:43 254

01-11-2012 16:56:45 254

01-11-2012 16:56:47 254

01-11-2012 16:36:49 254

01-11-2012 16:56:51 254

01-11-2012 16:56:53 254

01-11-2012 16:56:55 254

01-11-2012 16:56:57 254

01-11-2012 16:56:59 254

o1-11-2012 16:57:01 254

01-11-2012 16:57:03 254

01-11-2012 16:57:05 254

01-11-2012 16:57:07 254

01-11-2012 16:57:09 254

o1-11-2012 16:57:11 254

01-11-201216:57:13 254 w
1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.1.8 DL101T — Graph View

DL101T -101-1
[ < Temperature |
249005 +
249000
3
®
2 248995 4
©
o
o
E
@
2 I
248990 +
24 8985 +
174349 17:44:04 174419
01-11-2012 01-11-2012 01-11-2012
Time: 01-11-2012 17:44:23 Temp.:24.9(°C)

Our graph support following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.1.9 DL101T — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL101T is the same as Windows version, except the downloaded data

can only have 10,000 readings in a single download.
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6.2 DL121TH
DL121TH is a data logger for storing temperature and humidity reading.

6.2.1 Add new DL121TH
When Voltsoft detected a new DL121TH attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

Click “Yes”, the following dialog will be displayed:

\/ Add Hew Device

Cievice Series |Data Loager vl
Model Number  DL121TH v|
Alias 121TH| |

[.ﬂ'-.utD-Detect ] [ Add ] [ Cloze ]

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.2.2 Remove DL121TH

To remove DL121TH, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.2.3 DL121TH - Device Control Panel

< DL121TH-121

Device  dGraph

f" Data \ Graph \
PLC storage range Earliest data: 09-01-2013 22:43:10 Latest data:  10-01-2013 07:36: 28
2 Summary
Measuremernt Maximum Yalue Minitmum alue Average Walue
Temperature [C)
Relative Humidity (%)

Dewy Point (9]

All Data

Record Time Temperature (*C)

DL121TH contain follow items in menu:

1 Device -> Settings
2 Device -> Download Data

3 Device -> Display / Plot Data

4 Graph -> Plot Colour

5 Graph -> Background Colour

6 Graph -> Grid
7 Graph -> Line
8 Graph -> Points Indicator
9 Graph -> Print
10 Graph -> Save Image As

11  Graph -> Zoom Out
12  Graph -> Zoom To Fit

Export Excel ] [ Export C5W

Relative Humidity (95 Denwy Point (*C)

This will launch the setting page of DL121TH.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.2.4 DL121TH - Settings

N

10

11
12
13

\/121TH - Settings (HW ID:02_1211070004)

Basic Settings

Time

Logger Mame

Fecord Start Condition
sample Paints
Recarding Time

LED Flash Cycle

Alarm Settings
[ ] Enable LEDs Alert

Device connect.

Temperature Lowe Limit -40.0 2 0 % High Limit J00 5 PG

Relative Humidity  Low Limit 00 % %  High Limit 1000 5| %

Use System Time

121TH
() By Buttan () After Setup
16000 w sample Hate 25 w

8 Hours 53 Minutes 20 Seconds

*) 10s ) 20s ) 30s

Drefauilt ] [ Setup l [ Cloze

Time

Logger Name
Record Start Condition

Sample Points
Sample Rate
Recording Time

LED Flash Cycle

Enable LED Alert
Temperature Low / High
Alarm

Relative humidity Low /
High Alarm

Default Button

Setup Button

Close Button

Configure the device data time value.

The user can specify a defined time or use the system
date time.

Input the unique alias for that device.

By Button - The data logger will start recording only
after the user presses the red button on the device.

After Setup - The data logger will start recording
immediately after setup.

Instruct the logger to take a finite humber of readings.
Instruct the logger to log readings at a specific rate.
Calculate the recording time based on the selected
sample points and sample rate.

Configure the LED flash cycle - the longer the time, the
longer the battery life.

Enable / disable LED flash when the alarm is triggered.
Configure the temperature low / high alarm level.

Configure the humidity low / high alarm level.
Reload the factory default settings.

Save changes.
Close this interface.

Note: Any stored data will be permanently erased when setup is finished.
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6.2.5 DL121TH - Download Data

This module allows user to download the data from DL121TH.

Download Data

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recarding.

Device connect. ] l ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.2.6 DL121TH - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Plot D ata
() PC storage range Earliest data: WA, Latest data; MA&

) From: 09-12-2012 16:22:24 b Tao: 10122012 17:22:34 v

Device connect.

[ ok || cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.2.7 DL121TH - Data View

DL121TH contains three measurements (Temperature, relative humidity and dew point),
template / dew point unit can be Celsius or Fahrenheit, depending on the setting in general
setting.

Device  Graph

" Data |
PC storage range Earliest data: 10-10-2012 15:40:38 Latest data: 11-10-201 2 00:33:56
¥ Summary
All Data Export Excel ] [ E=poart C5Y
Record Time Temperature (*C) Relative Humidity (%) D Paint (*C)
10-10-2012 15:40:35 261 442 12497
10-10-2012 15:40:40 261 442 12497
10-10-2012 15:40:42 261 44.2 12487
10-10-2012 15:40:44 261 44.2 12487
10-10-2012 15:40:45 261 442 12497
10-10-2012 15:40:45 261 442 12497
10-10-2012 15:40:50 261 442 12497
10-10-2012 15:40:52 261 442 12497
10-10-2012 15:40:54 261 441 12583
10-10-2012 154056 261 441 12583
10-10-2012 1540055 261 441 1293
10-10-2012 15:41:00 261 441 1293
10-10-2012 15:41:02 261 440 12490
10-10-2012 15:41:04 261 440 12490
10-10-2012 15:41:06 261 44.0 1280
10-10-2012 15:41:05 261 434 1286
10-10-2012 15:41:10 261 439 1286
10-10-2012 15:41:12 261 439 1286
10-10-2012 15:41:14 261 439 1286
10-10-2012 15:41:16 261 439 1286
10-10-2012 15:41:18 261 434 1286
10-10-2012 15:41:20 261 434 1286
10-10-2012 15:41:22 261 439 1286
10-10-2012 15:41:24 261 439 1286
10-10-2012 15:41:26 261 439 1286
10-10-2012 15:41:25 261 439 1286
10-10-2012 15:44:30 261 439 1286
10-10-2012 15:41:32 261 434 1286
10-10-2012 15:41:34 261 439 1286
10-10-2012 15:41:36 261 439 1286
10-10-2012 15:41:358 261 439 1286
10-10-2012 15:41:40 261 439 1286
10-10-2012 15:41:42 261 439 1286
10-10-2012 15:41:44 261 434 1286
10-10-2012 15:41:46 26.1 43.8 1283
10-10-2012 15:41:45 261 437 12.79

1 Export Excel Export the reading to Excel (.xls) format.

2 Export CSV Export the reading to Excel (.csv) format.
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6.2.8 DL121TH — Graph View

Device  Graph
/ Data / Graph \
DL121TH - DL121TH
| * Temperature Relative Humidity > Dew Point
1 45
TR
25 1 _
+ 40
o
E | —
& 135 &
2 2
o 20 + =
(] E
5 -
Eg + 30 g
= ®
< ®
o 18
E_ L
E 15 1 + 25
|_ L
+ 20
10 s . . } . . t } t . . } . . t } t
15:44:00 15:45:00 154600 15:47:00
10-10-2012 10-10-2012 10-10-2012 10-10-2012
Time: 10-10-2012 15:47:12 Temp.:26(°C) RH:43.8(%) DP:12.74(°C)

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.2.9 DL121TH —Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL121TH is the same as Windows version, except the downloaded data
can only have 10,000 reading in a single download.
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6.3 DL141TH

DL141TH is a data logger for storing temperature and humidity readings.

6.3.1 Add new DL141TH
When Voltsoft detected a new DL141TH attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

Click “Yes”, the following dialog will be displayed:

\/ ~dd Mews Device

Device Series |Data Logger v|
Model Mumber  DL141TH v|
Alias 141TH| |

[.ﬁ.utD-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.3.2 Remove DL141TH

To remove DL141TH, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.3.3 DL141TH - Device Control Panel

" DL141TH - 141TH

Device

Graph

/

PC ztorage range

Data \ Graph "'.\

Earliest data:  19-12-2012 16:29:44

Latest data: 19-12-2012 16:29:52

heasurement

Maximum Yalue

Temperature (7C)
Relative Humidity (96
Dewy Poirt (*C)

inimum alue Average Value

All Data

Record Time

Temperature [(“C)

Relative Humidity (%)

Export Excel ] [ Export CSY

Dewv Pairt (°C)

The DL141TH Device Control Panel contains the following items in menu:

1 Device -> Settings This will launch the setting page of DL141TH.

2 Device -> Download Data Download reading from device.

3 Device -> Display / Plot Data Select the time range that the device reading
should be retrieved.

4 Graph -> Plot Colour This will launch the Plot Colour module to change
the colour of the individual lines.

5 Graph -> Background Colour Change the background colour of the graph to
either black or white.

6 Graph -> Grid Control whether to show / hide the grid on the
graph area.

7 Graph -> Line Control whether to show / hide the line on the
graph area.

8 Graph -> Points Indicator Control whether to show / hide the points
indicator.

9 Graph -> Print Prints the generated chart.

10 Graph -> Save Image As Save the image in the chosen file format.

11 Graph -> Zoom Out Zoom out one level.

12  Graph -> Zoom To Fit Undo all zoom in and out.
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6.3.4 DL141TH - Settings

\/|Logger 140 - Settings

Device Time

Basic Settings
Logger Narme

Sampling Rate
Recording Time
LED Flash Cycle

Recording

Alarrn Settings

Ternperature

Relative Humidity

Device connect,

Record Start Condition

Enable LEDs Alert

Use System Time

Logger 140

() By Button (=) After Setup

10 % s v
1 Day 21 Hours 25 Minutes

® 10s O 205 O 30s ) Disahle

O Circulating Record (=) Mo Circulating

Low Level -400 2| %2 High Level 700 2| °C

Low Level 0.0 5| % High Level 100.0 5| %

[ Ciefault ][ Setup H Cloze ]

1 Device Time

N

Logger Name
3 Record Start Condition

Sample Rate

5 Recording Time
6 LED Flash Cycle

7 Recording

Enable LED Alert
Temperature Low / High
Alarm

10 Humidity Low / High Alarm
11 Default Button

12  Setup Button

13 Close Button

O

Configure the device data time value.

User can specify a defined time or use the system date

time.

Enter the unique alias for that device.

By Button - The data logger will start recording only
after the user presses the red button on
the device.

After Setup - The data logger will start recording
immediately after setup.

Instruct the data logger to log readings at a specific

rate. The user can input specific data in the edit box on

the left and select the time unit using the combo box
on the right.

Calculate the recording time based on the selected

sample points and sample rate.

Configure the LED flash cycle - the longer the time, the

longer the battery life.

Instruct the data logger to continue logging data,

recording over the earlier data (Circulating Record), or

to stop logging (No Circulating) when the data logger
memory is full.

Enable / disable LED flash when the alarm is triggered.

Configure the temperature low / high alarm level.

Configure the humidity low / high alarm level.
Reload the factory default settings.

Save changes.

Close this interface.
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6.3.5 DL141TH - Download Data

This module allows user to download the data from DL141TH.

Download Data Q@@

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recarding.

Device connect. ] l ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.3.6 DL141TH - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Plot D ata
() PC storage range Earliest data: WA, Latest data; MA&

) From: 09-12-2012 16:22:24 b Tao: 10122012 17:22:34 v

Device connect.

[ ok || cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.3.7 DL141TH - Data View

DL141TH contains three measurements (Temperature, relative humidity and dew point),
template / dew point unit can be Celsius or Fahrenheit, depending on the setting in general
setting.

~ DL141TH - 141TH - X

Device  Graph

{l} Data \ Graph "'.\

PC storage range Earliest data:  15-10-2007 15:26:34 Latest data:  15-10-2007 15:29:37

Meazurement Maximum Yalue Minirmum Yalue Average Yalue

Temperature (") 2532 245 25.00

Relative Hurmidity (%) 493 465 47 56

Dy Paint (*C) 1327 1283 1308

All Data Export Excel ] [ Export CSY
Record Time Temperature (*C) Relative Humidity (%) Dewe Point (*C) A
13-10-2007 152634 246 493 1327

15-10-2007 15:26:35 246 493 1327

13-10-2007 132636 245 492 1324

15-10-2007 15:26:37 246 492 1324

15-10-2007 15:26:35 246 491 13.21

13-10-2007 15:26:39 246 441 132

1:5-10-2007 15:26:40 246 44.0 1318

1:3-10-2007 15:26:41 246 44.0 1318

15-10-2007 15:26:42 246 438 1315

15-10-2007 15:26:43 246 459 1315

13-10-2007 152644 247 4.6 132

15-10-2007 15:26:45 247 435 1321

1:3-10-2007 152646 247 4.6 1321

15-10-2007 15:26:47 247 488 132

15-10-2007 15:26:45 247 45.5 13.21

13-10-2007 15:26:49 247 4.6 132

15-10-2007 15:26:50 247 457 1318

1:3-10-2007 15:26:51 247 487 1318 v

1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.3.8 DL141TH - Graph View
et tanm | - X

Device  Graph
| Data 7 Graph \
! DL141TH -141TH
[ < Temperature Relative Hurmidity w Dew Point ]

30 T T T T T T T T 50

25 4
—_ + 40
[&] |
-9
£
E —_
5201 §
% + 30 5
2 :
oo T
5 .
3 TH %
St 2
o J
E
]
i + 10

5 4

0 t t t } t t t } t t t } t t t 0

15:26:00 15:27.00 15:28:00 15:29:00 15:30:00

15-10-2007 15-10-2007 15-10-2007 15-10-2007 15-10-2007

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.3.9 DL141TH — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL141TH is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.4 DL161S

DL161S is a data logger for storing sound level reading. DL161S supports real time
measurement.

6.4.1 Add new DL161S
When Voltsoft detected a new DL161S attached, the following dialog will be popped up:

Device Management System

Mew device detected, do vou want bo add it inko the syskem now?

Click “Yes”, following dialog will be displayed:

\/ Add Hew Device

Device Seties |Data Logger

Model Number  DL1E1S

Alias 1615

[.-’-‘-.utn:n-Detec:t ] [ Add ] [ Cloze ]

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.4.2 Remove DL161S

To remove DL161S, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.4.3 DL161S — Device Control Panel

~ DL1615 - 1615

Device

Graph

/

PC storage range

Data \

Graph

Earliest data: N4

Latest data: M4

Meazurement

Maximum Yalue

Sound Level dBA
Sound Level dBC

Minimum Y alue

Average YWalue

All Data

Record Time

Sound Level dBA

Sound Level dBC

Export Excel ] [ Export C5%

]

The DL161S Device Control Panel contains follow items in menu:

AWNRH

N O

10

11

12
13
14
15
16

Device -> Settings

Device -> Stop

Device -> Download Data
Device -> Display / Plot Data

Device -> Email Alert

Device -> Calibration
Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As
Graph -> Zoom Out

Graph -> Zoom To Fit
Graph -> View All Data

This will launch the setting page of DL161S.
Stop the real time data download.

Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the email alert module.
(Available in Professional version only)
Launch the calibration module.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.

Zoom out the graph to view all data.
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6.4.4 DL161S — Settings

u b wWwN

N

10

11

12

/[160 - Settings

Basic Settings
Time

Logger Mame
saund Unit
Measuring Speed
hode Setup
Sample Rate
Sample Paints
Recording Time
LED Flash Cycle
Record Start Candition
Storage Setup

Alarm Settings
Enable LEDs Alert

Sound Level

Sound Level

Device connect.

() dBA
(*) Fast
) Peak

1 Day 12 Hours 5 Minutes 20 Seconds
() 10s

) Stare

Lowy Level (30 | dBA

Lo Level (30 5 dBC

Use System Time

O dBC
O Slow
) Mormal
w | |8 4

Infinite

O 203
By Button

O 30s
(@) After Setup
(*) Real Time

O Dizable

High Level 130 5| dBA

High Level 130 3 |dBC

[ Ciefault ” Setup H Cloze ]

Time

Logger Name

Sound Unit

Measuring speed
Record Start Condition

Sample Rate

Sample Points
Infinite

Recording Time
LED Flash Cycle

Logger Mode

Storage Setup

Configure the device data time value.

User can specify a defined time or use the system date

time.

Input the unique alias for that device.

The sound unit can be dBA or dBC.

The measuring speed can be Fast or Slow.

By Button - The data logger will start recording only
after the user pressed the red button on
the device.

After Setup - The data logger will start recording
immediately after setup.

Instruct the data logger to log readings at a specific

rate.

Configure the data logger sample points.

For real time mode only, the download will not stop

until the user stopped the download.

Calculate the recording time based on the selected

sample points and sample rate.

Configure the LED flash cycle - the longer the time, the

longer the battery life.

Manual - The data logger will start recording only
after the user presses the red button on
the device.

Instant - The data logger will start recording

immediately after setup.
Storage can be Store or Real Time.

Store - The data will be stored in offline mode.
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Real Time - The data will be stored in real time
mode.
13 LED Flash for High / Low Enable / disable LED flash when the alarm is triggered.
Alarm

14  Low / High Alarm for dBA Configure the sound level (at unit dBA) for the low /
high alarm level.

15 Low / High Alarm for dBC Configure the sound level (at unit dBC) for the low /
high alarm level.

16 Default Button Load the factory default settings.
17 Setup Button Save changes.
18 | Close Button Close this interface.

6.4.5 DL161S - Download Data

This module allows user to download the data from DL161S.

Download Data

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recarding.

Device connect. ] l ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.4.6 DL161S — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Flat Data
(O PCStarage Rangs Earliest data:  M./& Latest data: Current Time

) From: 26-01-2013 173817 » To:r | 2701-2001318:3817 %

() Real Time Data

Device connect.

[ o || owmse |

1 PC Storage Range Download all data stored in the database.

2 Time Range Select the data reading range.

3 Real Time Data Download real time data, will only enable if the device
in real time mode.

4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.4.7 DL161S — Data View

DL161S contains two measurements (sound level in dBA and sound level in dBC), the device
can record only one measurement at any specific unit of time (Control in Setting).

< DL1615 - 1615 * X

Device  Graph

/ Data \ Graph "'.‘
PC storage range Earliest data:  27-01-2013 18:20:24 Latest data:  Current Time
2 Sumrnary

| Measuremert Maccimum Yalue Minimum %alue Average Walue
Sound Level dBA T01 5248 9973

Sound Level dBC

All Data Export Excel ] [ Expart CSY
Recard Time Sound Level dBa, Sound Level dBC ~

27-01-2013 152024 261

27-01-2013 1820025 551

27-01-2013 18:20: 26 550

27-01-2013 1820027 936

27-01-2013 18:20:28 5349

27-01-2013 18:20:29 6.7

27-01-2013 18:20:30 567

27-01-201318:20:3 574

27-01-2013 1820032 arT

27-01-2013 18:20:33 534

27-01-2013 18:20:54 ary

27-01-2013 18:20:35 6.2

27-01-2013 18:20:36 538

27-01-2013 182057 5249

27-01-2013 18:20:38 541

27-01-2013 18:20:39 245

27-01-2013 18:20:40 6.0

27-01-2013 1532041 26.0 w

1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.4.8 DL161S — Graph View
_/DLIGIS- 1615 | - X

| Device draph

"- Data / Graph \

H DL161S - 161S
[ X SoundLeveldBA Sound Level dBC |
75 T T T T T T T T T T T T T T T T T
70 +

T 1 -

s 7T . : "

J o x

k=] l b &

g 1 ;

3 60 | y

»n 1 5 A b

55 1 =
50 1+
18:20:14 18:20:44 18:21:14 18:21:44
27-01-2013 27-01-2013 27-01-2013 27-01-2013
Time

Our graph support following operations
1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in
3 Shift + mouse click Pan
4 Mouse over on point Display reading values
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6.4.9 DL161S — Email Alert

\/ Email Alert E| |§|E|

Recipient(z] Lzt

Following receipient[z] will receive email alert

johrzmitiigmail. com

As DL161S supports real time measurement, therefore, it has an email alert feature, which will
send out an email to the specified user when the device reading is above or below a certain
level. The alert level can be configured in Setting.

User can use this module to select who will receive the email for the specific device.

6.4.10 DL161S - Calibration

DL161S provides an interface to the user for sound level calibration. The calibration
adjustment value is allowed between -12.5 dB and 12.5 dB.

Calibration Adjustment [Z| |E|rg|

Adjustment Yalue

2.0 v

(-12.5dE to 12.54E)

Device connect. [ oK ] ’ Cancel

Enter the value and click "OK” to set the value.
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6.4.11 DL161S — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL161S is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.5 DL181THP

DL181TH is a data logger for storing temperature, humidity and air pressure reading.

6.5.1 Add new DL181THP
When Voltsoft detected a new DL181THP attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

Click “Yes”, the following dialog will be displayed:

\/ Add Hew Device

Device Series |Data Logger

fodel Mumber |DL1 1 THF

Alias 181THA

[.ﬁ.utD-Detect ] [ Add l [

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.5.2 Remove DL181THP

To remove DL181THP, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.5.3 DL181THP - Device Control Panel
DL1E1THP - 181THP ] - M
Device  Graph
," Data \' Graph §
FC storage range Earliest data:  27-01-2013 22:11:45 Latest data;  27-01-2013 22:20:45
¥ Summary
All Data Export Excel ] [ Expart CSW ]
Recard Time Tempersture [*C) Relative Humidity (%) Air Pressure (hPs)
27-01-2013 2211:45 236 565 £896.05
27-01-2013 221245 238 533 895265
27-01-2013 221345 241 521 89525
27-01-2013 22:14:45 242 539 89515
27-01-2013 221545 242 a7 895135
27-01-2013 221645 242 1.4 89505
27-01-2013 221745 242 512 £94 BS
27-01-2013 221845 242 1.2 894 85
27-01-2013 221945 242 1.4 £94 95
27-01-2013 22:20:45 243 534 £94 .85

The DL181THP Device Control Panel contains the following items in menu:
1 Device -> Settings
2 Device -> Download Data

3 Device -> Display / Plot Data

4 Graph -> Plot

5 Graph -> Background Colour

6 Graph -> Grid

7 Graph -> Line

Colour

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11  Graph -> Zoom Out
12  Graph -> Zoom To Fit

This will launch the setting page of DL181THP.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.5.4 DL181THP - Settings

/1 81THP: - Settings (HW ID:0004_12101700002)

Basic Settings

Time Ugze Systermn Time
Logger Mame 181THP

Record Start Condition ) By Button (&) After Setup

Sample Rate 0 2 Hours) 1 5| Minute(s)

Sarple Points 10000 5

Recarding Time 6 Days 22 Hours 40 Minutes

Enable LEDs Record 10 2| Sec(s)

Alarm Settings

Enable LEDs Alert 1 | Secis)

Temperature Low Level -400 5| eC High Level 700 |Z| °C
Hurnidity Low Level 0.0 s High Level 1000 $| %
Air Pressure Low Level 7000 2| hPa  High Level 11000 % | hPa

Device connect.
’ Drefault ] [ Setup ] [ Cloge l

1 Time

2 Logger Name

3 Record Start Condition

4 Sample Rate

5 Sample Points

6 Recording Time

7 Altitude

8 Record LED Flash

9 Enable LED Alert

10 Temperature Low / High
Alarm

11  Humidity Low / High Alarm

12  Air Pressure Low / High
Alarm

13  Default Button

14  Setup Button

15 Close Button

Configure the device data time value.

The user can specify a defined time or use the system

date time.

Input the unique alias for that device.

By Button - The data logger will start recording only
after the user presses the red button on
the device.

After Setup - The data logger will start recording
immediately after setup.

Instruct the data logger to log readings at a specific

rate.

Configure the data logger sample points.

Calculate the recording time based on the selected

sample points and sample rate.

Allows user to set the current altitude.

Configure the LED flash cycle - the longer the time, the

longer the battery life.

Enable / disable LED flash when the alarm is triggered.

Configure the temperature low / high alarm level

Configure the humidity low / high alarm level
Configure the air pressure low / high alarm level

Load the factory default settings.

Save changes.
Close this interface.
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6.5.5 DL181THP - Download Data

This module allows user to download the data fromm DL181THP.

Download Data Q@@

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recarding.

Device connect. ] l ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.5.6 DL181THP - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Plot D ata
() PC storage range Earliest data: WA, Latest data; MA&

) From: 09-12-2012 16:22:24 b Tao: 10122012 17:22:34 v

Device connect.

[ ok || cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.5.7 DL181THP - Data View

DL181THP contains three measurements (Temperature, relative humidity and pressure),
template unit can be Celsius or Fahrenheit and pressure unit can be hPa / kPa / Bar / SPI,
depending on the setting in general setting.

DL1&1THP - 181THP ] - X

Device  Graph

," Data \' Graph "'.I‘

FC storage range Earliest data:  27-01-2013 22:11:45 Latest data;  27-01-2013 22:20:45
¥ Summary |
All Data Export Excel ] [ Expart CSW ]
Recard Time Tempersture [*C) Relative Humidity (%) Air Pressure (hPs)
27-01-2013 2211:45 236 565 £896.05
27-01-2013 221245 238 533 895265
27-01-2013 221345 241 521 89525
27-01-2013 22:14:45 242 539 89515
27-01-2013 221545 242 a7 895135
27-01-2013 221645 242 1.4 89505
27-01-2013 221745 242 512 £94 BS
27-01-2013 221845 242 1.2 894 85
27-01-2013 221945 242 1.4 £94 95
27-01-2013 22:20:45 243 534 £94 .85
1 Export Excel Export the reading to Excel (.xlIs) format.
2 Export CSV Export the reading to Excel (.csv) format.

65



Voltsoft User Manual Version 2.0

6.5.8 DL181THP — Graph View

DL181THP - 151 THP l - X

Device  Graph

Data / Graph \

DL181THP - 181THP
[ Temperature Relative Hurmidiy ¥ Air Pressure |

B0 T T 8982
— B + B96.0
==
-.’E' 50 1 T 5958
5
T + 8956 =
g
5 18354 T
@ 40 + g
o + 8952 E
o =
E 18950 <
s
@ 30 +
E + 594.8
@ ]
- T 8246

e '
20 - : : : : - - : - : - 1 8944
22:10:00 22:15:00 22:20:00
27-M-2013 27-M-2013 27012013

Our graph support following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values
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6.5.9 DL181THP — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL181THP is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.6 DL111K

DL111K is a data logger for storing temperature reading.

6.6.1 Add new DL111K
When Voltsoft detected a new DL111K attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

Click “Yes”, the following dialog will be displayed:

\/ Add Mew Device

Device Series |Data Loager v|
Model Number | DL111K v |
Alias 111K |

[.-’-‘-.utl:n-Detect ] [ Add l [ Clogze ]

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.6.2 Remove DL111K

To remove DL111K, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device want to remove and click the "Remove” button.
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6.6.3 DL111K — Device Control Panel

< DL111K - 111K

Device  Graph

ll’ Data \

Graph

PC storage range Earliest data: p/a,

{4 Summary

Latest data:  N/&

Measurement Maximum Yalue

hinimum “alue

Average Yalue

All Data

Record Time Temperature 52

Export Excel ] [ Export C54

The DL111K Device Control Panel contains the following items in menu:

[y

Device -> Settings
Device -> Download Data
3 Device -> Display / Plot Data

N

4 Graph -> Plot Colour

5 Graph -> Background Colour
6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11  Graph -> Zoom Out
12  Graph -> Zoom To Fit

This will launch the setting page of DL111K.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.6.4 DL111K — Settings

N

10
11
12

/111K - Settings (HW ID:0017_07030100001)

Basic Settings

Time

Logger Mame

Record Start Condition
Delay Time

oample Hate

LED Flash Cycle

Alarm Settings
LInit

Loy Level

Device connect.

() By Buttan (3) After Setup

0 Sec A

) 10s () 20s (0305 () Mo Light

Termperature "C W

-200

Use System Time

s
= | Second v

- High Leval 1370

4

Drefault H Setup H Cancel

Time

Logger Name
Record Start Condition

Delay Time

Sample Rate
LED Flash Cycle

Unit

Temperature Low / High
Alarm

Default Button

Setup Button

Close Button

Configure the device data time value.

The user can specify a defined time or use the system

date time.

Input the unique alias for that device.

By Button - The data logger will start recording only
after the user pressed the red button on
the device.

After Setup - The data logger will start recording
immediately after setup.

Only available if “After Setup” selected.

Specify the delay time for recording start after setup.
Instruct the logger to log readings at a specific rate.
Configure the LED flash cycle - the longer the time, the
longer the battery life.

Select temperature unit (Celsius or Fahrenheit)
Configure the temperature low / high alarm level.

Reload the factory default settings.

Save changes.
Close this interface.
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6.6.5 DL111K - Download Data

This module allows user to download the data from DL181THP.

Download Data Q@@

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recording.

Device connect. k. ] ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.6.6 DL111K — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

o

Display f Plot Data

Dizplay ¢ Plok Drata

) PC Storage Flange

&+ Fram:

Measurement

Earliest data:  05-02-2013 18:24:04 Latest data: 05-02-2013 18:35:23

04-02-2013 18:56:09 b To: | 05-02-2013 13:56:09 w

Temperature °C W

ok || Close

N =

5

PC Storage Range
Time Range
Measurement

OK

Cancel

Download all data stored in the database.

Select the data reading range.

User can select Celsius or Fahrenheit record to
download.

Click OK to accept the input and display the selected
reading in the data and graph tabs.

Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.6.7 DL111K — Data View

DL111K contains one measurement (Temperature) only, its unit can be Celsius or Fahrenheit,
and can be selected in Display / Plot Data dialog.

< DL111K - 111K - X

Device  Graph
,l’ Data \ Graph 4

PC storage range Earliest data:  06-02-2013 16:20:24 Latest data:  07-02-2013 01:10:31
¥ Summary
All Data Export Excel l [ E zpart C5Y l
Record Time Temperature % -~
05-02-2013 16:20:40 252
05-02-201316:20:41 252
05-02-2013 16:20:42 251
05-02-2013 16:20:43 250
05-02-2013 16:20:44 250
05-02-2013 16:20:45 252
05-02-2013 16:20:46 251
05-02-2013 16:20:47 252
05-02-2013 16:20:45 252
0E-02-20135 16:20:49 249
0E-02-2013 16:20:50 250
0E-02-2013 16:20051 250
06-02-2013 16:20052 250
06-02-2013 16:20055 250
06-02-2013 16:20054 250
06-02-2013 16:20055 249
06-02-2013 16:20:56 251
06-02-2013 16:20:57 252
06-02-2013 16:20:58 252
06-02-201316:20:58 251
05-02-201316:21:00 251
06-02-201316:21:01 252
06-02-201316:21:02 252
06-02-201316:21:03 252
06-02-201316:21:04 231
06-02-2013 16:21:05 231
06-02-2013 16:21:06 252
06-02-201316:21:07 251 i
1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.6.8 DL111K — Graph View

< DL111K - 111K

Device  fraph

Data / Graph

DL111K - 111K

[ % Temperature "C |

255 S——
254 1+
253 1+
25.2 -

251

Temperature °C

250

249 T

248 T t t I + " 1 I }

16:20:00 16:22:00 16:24:00
06-02-2013 06-02-2013 06-02-2013

. | i
16:26:00
06-02-2013

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.6.9 DL111K — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL111K is the same as Windows version, except the downloaded data

can only have 10,000 readings in a single download.
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6.7 DL191A

DL191A is a data logger for measuring current.

6.7.1 Add new DL191A
When Voltsoft detected a new DL191A attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

s J[ mw

Click “Yes”, the following dialog will be displayed:

\/ Add New Device o)

Device Seties |Data Loager

Model Number | DL1314

Alias 1914

[.-’-‘-.ut-:u-DetEn:t ] [ Add ] [ Cloze ]

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.7.2 Remove DL191A

To remove DL191A, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.7.3 DL191A - Device Control Panel

Device  Graph

/ Data \

Graph

PC storage range

Earliest data:  29-03-201317:32:30

Latest data:  29-03-201317:32:52

a Summary
deasurement Mazimum Yalue Minimum % alue Average Value
Currert (ma) 0.0z 0.0z 0.0z

All Data Export Excel ] [ E=port C5Y
Record Time Current (ma)

29-03-201317:3230 n.oz

29-03-201317:32:32 0.0z

29-03-201317:32:34 n.oz

29-03-201317:3236 n.oz

29-03-201317:32:35 0.02

29-03-201317:32:40 n.oz

29-03-201317:32:42 n.oz

29-03-201317:32:44 0.02

29-03-201317:32:46 n.oz

29-03-201317:32:45 n.oz

29-03-201317:32:50 0.02

29-03-201317:32:52 n.oz

The DL191A Device Control Panel contains the following items in menu:

[Ty

Device -> Settings
Device -> Download Data
3 Device -> Display / Plot Data

N

4 Graph -> Plot Colour

5 Graph -> Background Colour
6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11  Graph -> Zoom Out
12  Graph -> Zoom To Fit

This will launch the setting page of DL191A.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.7.4 DL191A — Settings

/1914 - Settings (HW ID:0014_120%0600001)

Basic Settings

Titne

Logger Mame

Recaord Start Condition
sample Points
sample Rate

Recard LED Flash

Alarm Settings
Enable LED Alert

Lowe Lewel

Device cannect,

1914

() By Buttan (+) After Setup

32000 w

® 10s O 20s O 30s

Use System Time

> High Level 20

4

Drefault H Setup ][ Cloze

1 Time

N

Logger Name
3 Record Start Condition

Sample Points
Sample Rate

Ul b~

()]

Record LED Flash

Enable LED Alert
Low / High Alarm
Default Button
Setup Button
Close Button

= = O 0N
= O

Configure the device data time value.

The user can specify a defined time or use the system

date time.

Input the unique alias for that device.

By Button - The data logger will start recording only
after the user pressed the red button on
the device.

After Setup - The data logger will start recording
immediately after setup.

Configure the data logger sample points.

Instruct the data logger to log readings at a specific

rate.

Configure the LED flash cycle - the longer the time, the

longer the battery life.

Enable / disable LED flash when the alarm is triggered.

Configure the low / high alarm level for current.

Load the factory default settings.

Save changes.

Close this interface.
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6.7.5 DL191A - Download Data

This module allows user to download the data from DL191A.

Download Data

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recarding.

Device connect. ] l ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.7.6 DL191A - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Plot D ata
() PC storage range Earliest data: WA, Latest data; MA&

) From: 09-12-2012 16:22:24 b Tao: 10122012 17:22:34 v

Device connect.

[ ok || cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click on OK to accept the input and display the selected
reading in the data and graph tabs.
4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.7.7 DL191A — Data View

DL191A contains one measurement (current) only.

- DL191A - 1914

Device  Graph

i

PC storage range

¥ Summary

Graph Il"'.

Earliest data: 29-03-2013 17:32:30 Latest data:  29-03-2013 17.32:52

All Data

Recard Time
29-03-2013 173230
29-03-2013 173232
29-03-20M3 173234
29-03-2013 173236
29-03-20M3 173238
29-03-2013 173240
29-03-21M 3173242
29-03-2013 173244
29-03-2013 173246
29-03-2013 173248
29-03-2013 173250
29-03-2013 173252

1

Export Excel
Export CSV

Current (ma)

0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z

Ewport Excel

Ewport C5W ]

Export the reading to Excel (.xls) format.
Export the reading to Excel (.csv) format.
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6.7.8 DL191A — Graph View
DL191A- 1914 | - X

|l Device Graph
I Data / Graph \
DL191A - 191A
[ > Current(m#) |
00210 ————————7————— T T T
0.0205 |
=3
E I
e 0.0200 +
E ]
5
Q
0.0195 1
0.0190“::::}::::}::::I::::}::::}::
17:32:2 17:32:32 17:32:37 17:32:42 17:32:47 17:32:52
29-03-2013 29-03-2013 29-03-2013 29-03-2013 29-03-2013 29-03-2013

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.7.9 DL191A — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL191A is the same as Windows version, except the download data can
only have 10,000 readings in a single download.
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6.8 DL191V

DL191V is a data logger for measuring voltage.

6.8.1 Add new DL191V
When Voltsoft detected a new DL191V attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

Click “Yes”, the following dialog will be displayed:

\/ Add New Device MISIES

Device Series |Data Loager v|
Model Mumber  DL1STY v|
Alias 1914 |

[.ﬁ.utD-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.8.2 Remove DL191V

To remove DL191V, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.8.3 DL191V - Device Control Panel
- DL191¥ - 191 - X
Device  @raph
'Ji Data Graph \
P storage range Earliest data: 18-03-2013 12:18:01 Latest data:  18-03-201312:13:20
¥ Sumrnary
All Data Export Excel ] [ Expart CSY ]
Record Time Woltage (V) ~
18-03-2013 12:18:01 .0000 1.1
18-03-2013 1218:01 0025 1.1
18-03-2013 12:18:01 0050 110
18-03-2013 1218:01 0075 1.10
18-03-201312:18:01 0100 110
18-03-2013 121801 0125 1.10
18-03-20131218:01 0150 110
18-03-2013 12180 0175 1.10
18-03-2013 12:18:01 0200 110
18-03-2013 1218:01 0225 1.10
18-03-2013 12:18:01 0250 1.08
18-03-2013 1218:01 0275 1.10
18-03-2013 12:18:01 0300 1.08
18-03-2013 1218:01 0325 1.09
18-03-2013 12:18:01 0350 1.08
18-03-20131218:01 0373 1.10
18-03-2013 12:18:01 .0400 1.08
18-03-2013 1218:01 0425 1.10
18-03-2013 12:18:01 0450 110
18-03-2013 1218:01 0475 1.10
18-03-2013 12:18:01 0500 110
18-03-2013 1218:01 0525 1.1
18-03-2013 12:18:01 0550 110
18-03-2013 1218:01 0575 1.1
18-03-2013 12:18:01 0600 110
18-03-2013 1218:01 0625 1.10
18-03-2013 12:18:01 0650 1.1 3

149 M2 N1 24-12-M1 NeETE

44N

The DL191V Device Control Panel contains the following items in menu:

1 Device -> Settings

2 Device -> Download Data

3 Device -> Display / Plot Data
4 Graph -> Plot Colour

5 Graph -> Background Colour
6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11  Graph -> Zoom Out

12  Graph -> Zoom To Fit

This will launch the setting page of DL191V.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.8.4 DL191V — Settings

\/[191¥ - Settings (HW ID:0013_12080700003)

Baszic =ettings

Tirne
Logger Mame

Record Stant Condition

Sample Paints
Sample Rate
LED Flash Cycle

Alarm Settings
Enable LED Alert

Lowy Level

Device connect.

Use System Time
191
) By Buttan (%) After Setup
32000 b
25 hd
® 10s C 20s O 30s
a E High Level 20 £
[ Default ] [ Setup ] [ Cloge

1 Time

N

Logger Name
3 Record Start Condition

Sample Points
Sample Rate

Ul b~

()]

Record LED Flash

Enable LED Alert
Low / High Alarm
Default Button
Setup Button
Close Button

= O 00N
=]

Configure the device data time value.

The user can specify a defined time or use the system

date time.

Input the unique alias for that device.

By Button - The data logger will start recording only
after the user pressed the red button on
the device.

After Setup - The data logger will start recording
immediately after setup.

Configure the data logger sample points.

Instruct the data logger to log readings at a specific

rate.

Configure the LED flash cycle - the longer the time, the

longer the battery life.

Enable / disable LED flash when the alarm is triggered.

Configure the low / high alarm level for voltage.

Load the factory default settings.

Save changes.

Close this interface.
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6.8.5 DL191V - Download Data

This module allows user to download the data from DL191V.

Download Data

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recarding.

Device connect. ] l ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.8.6 DL191V - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Plot D ata
() PC storage range Earliest data: WA, Latest data; MA&

) From: 09-12-2012 16:22:24 b Tao: 10122012 17:22:34 v

Device connect.

[ ok || cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.8.7 DL191V — Data View
DL191V contains one measurement (voltage) only.

< DL191Y - 191 - X

Device  @raph

'Ji Data

P storage range

Earliest data;

Graph '._|

18-03-2013 12:18:1 Latest data:  18-03-201312:19:20

¥ Sumrnary
All Data Export Excel ] [ Expart CSY ]
Record Time Woltage (V) ~
18-03-2013 12:18:01 .0000 1.1
18-03-2013 1218:01 0025 1.1
18-03-2013 12:18:01 0050 110
18-03-2013 1218:01 0075 1.10
18-03-201312:18:01 0100 110
18-03-2013 121801 0125 1.10
18-03-20131218:01 0150 110
18-03-2013 12180 0175 1.10
18-03-2013 12:18:01 0200 110
18-03-2013 1218:01 0225 1.10
18-03-2013 12:18:01 0250 1.08
18-03-2013 1218:01 0275 1.10
18-03-2013 12:18:01 0300 1.08
18-03-2013 1218:01 0325 1.09
18-03-2013 12:18:01 0350 1.08
18-03-20131218:01 0373 1.10
18-03-2013 12:18:01 .0400 1.08
18-03-2013 1218:01 0425 1.10
18-03-2013 12:18:01 0450 110
18-03-2013 1218:01 0475 1.10
18-03-2013 12:18:01 0500 110
18-03-2013 1218:01 0525 1.1
18-03-2013 12:18:01 0550 110
18-03-2013 1218:01 0575 1.1
18-03-2013 12:18:01 0600 110
18-03-2013 1218:01 0625 1.10
18-03-2013 12:18:01 0650 1.1 3
A2 N2 MM 241201 NETE 11N

1 Export Excel

2 Export CSV

Export the reading to Excel (.xls) format.
Export the reading to Excel (.csv) format.
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6.8.8 DL191V — Graph View

< DL191Y - 191¥ - X

Device  Graph
Data I/ Graph \

DL191V - 191V
14 1 T T T T T T T T T
1.2 +
S— o T
1.0 +
g 08
S
S 06 F
04 +
0.2 +
00 ' — —— —1 ——1 .
12:17:53.0000 12:18:23.0000 12:18:53.0000 12:19:23.0000
18-03-2013 18-03-2013 18-03-2013 18-03-2013
Time: 18-03-2013 12:18:30 Voltage:0.003

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.8.9 DL191V — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL191V is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.9 DL151AN

DL151AN is a data logger for measuring air velocity.

6.9.1 Add new DL151AB
When Voltsoft detected a new DL151AN attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

Click “Yes”, the following dialog will be displayed:

\/ Add Hew Device

Device Series |Data Logger v|
Model Mumber | DL1S1AN v/
Alias 151N |

[.ﬁ.utD-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click “*Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.9.2 Remove DL151AN

To remove DL151AN, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.9.3 DL151AN - Device Control Panel

A DL151AM- 151 - A

Dewvice  Graph
x Data \ Graph |

PC starage range Earliest data: 29-03-2013 21:38:22 Latest data:  23-03-2013 21:40:03

% Surnmary

All Data E zpart Excel ] [ Expart C5Y ]

Record Time Lnitgmiz) -~

20-03-2013 21,3822 0.a0

29-03-2013 213524 3482

29-03-2013 21,3526 341

29-03-2013 21,3828 4.81

29-03-2013 21.38.30 214

28-03-2013 13832 545

28-03-2013 213834 4 B2

28-03-2013 21:38.36 189

29-03-2013 21:38:38 6.09

29-03-2013 21:35:40 176

20-03-2013 21,3542 240

20-03-2013 213544 119

29-03-2013 21,3546 1.20

29-03-2013 21,3545 221

29-03-2013 21,3550 1.06

29-03-2013 21,3852 0.a0

29-03-2013 213854 360

28-03-2013 1. 38:56 1.38

28-03-2013 1. 38:58 160

29-03-2013 21:39:00 335

29-03-2013 24:39:02 4493

29-03-2013 21:39:04 183

29-03-2013 21:39: 41 0.a0

20-03-2013 21.39:43 0.a0

29-03-2013 21.39:45 0.a0

29-03-2013 21.39:47 4 65

289-03-2013 21.39:49 465

ORI A0 51 181 v

The DL151AN Device Control Panel contains the following items in menu:

1
2
3

10
11
12

Device -> Settings

Device -> Download Data
Device -> Display / Plot Data
Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of DL151AN.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.9.4 DL151AN - Settings

\/ 151 - Settings (HW ID:0011_12101000002)

Basic Settings

Time Use System Time
Logger Marme 151

Record Start Condition O By Button (%) After Setup

Sample Points 32000 w

sample Rate 25 w

LED Flash Cycle () 10s () 20s () 30s

Alarm Settings
Enable LED Alert
Low Level |0 % High Level 14 & Unit |mfs v

w w

Device connect,

Drefauilt ] [ Setup ] [ Claze

1 Time Configure the device data time value.

The user can specify a defined time or use the system
date time.

2 Logger Name Input the unique alias for that device.

3 Record Start Condition By Button - The data logger will start recording only
after the user presses the red button on
the device.

After Setup - The data logger will start recording
immediately after setup.

4 Sample Points Configure the data logger sample points.

5 Sample Rate Instruct the data logger to log readings at a specific

rate.

6 Record LED Flash Configure the LED flash cycle - the longer the time, the

longer the battery life.

7 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

8 Low / High Alarm Configure the low / high alarm level for air velocity.

9 Default Button Load the factory default settings.

10 Setup Button Save changes.

11  Close Button Close this interface.
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6.9.5 DL151AN - Download Data

This module allows user to download the data from DL151AN.

Download Data

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recarding.

Device connect. ] l ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.9.6 DL151AN - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display / Plot Data E]|E|@

Digzplay / Plat Drata
() PC Storage Range Earliest data:  23-03-2013 21:38:22 Latest data: 23-03-2013 27:40:03
(+) Fram: 28-03-2013 220313 W To: | 29-03-2013 230313 W
Measurerment nit[m.z) hd
| ok || close
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 Measurement User can select which measurement unit to download.
4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.9.7 DL151AN - Data View

DL151AN contains one measurement (air velocity) only, but in different unit (m/s, ft/min,
knots, km/h and MPH).

~ DL151AN- 151 * X

Dewvice  Graph

x Data \ Graph |
PC starage range Earliest data: 29-03-2013 21:38:22 Latest data:  23-03-2013 21:40:03
% Surnmary |
All Data E zpart Excel ] [ Expart C5Y ]
Record Time Unit(rmiz) ~
29-03-2013 21:38:22 0.0a
29-03-2013 21:358:24 3.482
29-03-2013 21:38:26 3.4
29-03-2013 21:38:28 4.81
29-03-2013 21:38:30 214
29-03-2013 21:38:32 545
29-03-2013 21:38:34 462
29-03-2013 213836 1.89
29-03-2013 21:38:38 5.09
29-03-2013 21:38:40 1.76
29-03-2013 21:38:42 2.40
29-03-2013 21:35:44 1.19
29-03-2013 21:358:46 1.20
29-03-2013 21:358:45 ey
29-03-2013 21:38:390 1.06
29-03-2013 21:38:92 0.s0
29-03-2013 21:38:24 3.60
29-03-2013 21:.38:56 1.38
29-03-2013 21:38:58 160
29-03-2013 21:39:.00 335
29-03-2013 21:39:02 449
29-03-2013 21:39:04 1.835
29-03-2013 21:39: 41 0.0a
29-03-2013 21:39:43 0.0a
29-03-2013 21:39:45 0.0a
29-03-2013 21:39:47 4 65
29-03-2013 21:39:49 4 65
= ek Rl R | 1 &4 b
1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.9.8 DL151AN — Graph View

~"DL151AN - 151 - X

Device  Graph
Data / Graph \

DL151AN - 151

[ X Unit(m/s) |
7 T T T T T T

Unit(ml/s)

0 i —e el s
21:38:11 21:38:41 21:39:11 21:39:41 21:40:11
29-03-2013 29-03-2013 29-03-2013 29-03-2013 29-03-2013

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.9.9 DL151AN - Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL151AN is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.10 IR 1200-50D

IR 1200-50D is a data logger for measuring temperature.

6.10.1 Add new IR 1200-50D
When Voltsoft detected a new IR 1200-50D attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

Click “Yes”, the following dialog will be displayed:

\/ Add New Device

Dievice Series |Data Logger

Model Mumber |IH 1200-500

Alias 1200500

[.-’-‘-.ut-:u-DetEn:t ] [ Add ] [

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.10.2 Remove IR 1200-50D

To remove IR 1200-50D, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.

92



Voltsoft User Manual Version 2.0
6.10.3 IR 1200-50D — Device Control Panel
/m - X

Device  G@raph

; \

Graph '."

All Data [ Export Excel ] [ Export C5Y ]
Record Time IR (72 I = ‘ l ]

EMS:| 0

IR Max: |0 IR Min:| 0

IR AVG: |0 IR DIF:| O

IR: O C

TK: N / ﬂ

1/1/0001 12:00:00 AM

The DL151AN Device Control Panel contains the follow items in menu:

1 Device -> Settings
2 Device -> Display / Plot Data

3 Graph -> Plot Colour

4 Graph -> Background Colour
5 Graph -> Grid

6 Graph -> Line

7 Graph -> Points Indicator

8 Graph -> Print

9 Graph -> Save Image As

10 Graph -> Zoom Out
11  Graph -> Zoom To Fit

This will launch the setting page of DL191V.
Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.10.4 IR 1200-50D — Settings

\/ 1200 - Settings (HW ID:0018_13012400001) M=

Logger Mame: |1 200 |

sample Rate

Il 4| Second v
| Setup | | Close
1 Logger Name Input the unique alias for that device.
2 Sample Rate Instruct the data logger to log readings at a specific
rate (for real time mode only).
3 Setup Button Save changes.
4 Close Button Close this interface.
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6.10.5 IR 1200-50D — Play (Real Time Mode)

Click the “Play” button in device control panel will switch IR 1200-50D into real time mode and
the button label will become “Stop”, click it again to leave real time mode.

IR 1200-50D - 1200 - X

Device  Graph

f/ Data \ Graph II".ll

PC storage rangs Earliest data:  05-03-2013 16:56:25 Latest data:  05-03-2013 17:09:20

¥ Summary |

All Data [ E=part Excel ] [ Export C5Y ]

Record Time IR (%) EM=

[I | (==
| |

In real time mode, pressing the trigger on the device will start sending data to PC, no data will
be sent if the trigger is not pressed.

IR 1200-50D - 1200 - X

Device  G@raph

/ Data \' Graph I"."

FC storage range Earliest data:  05-03-2013 16:56:25 Latest data: Current Time

¥ Summary |

All Data [ Export Excel ] [ Export C5Y ]

[ oo |

Record Time IR (72

EMS:|O
IR Max: |0 IR Min:|O
IR AVG: |0 IR DIF:|0

IR: O C
“INTA

1/1/0001 12:00:00 AM
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6.10.6 IR 1200-50D — Download Store Data

Click the “"Download Logger” button in the device control panel will trigger the download data
action, and the following dialog will be popped up:

~ IR 1200-50D - 1200 - X

Device  Graph

f Data \ Graph "'\
PLC storage range Earliest data:  05-03-2013 165625 Latest data: 05-03-201317:09:20
¥ Summary
All Data Export Eucel ] [ Expart CSY
Recard Time IR

To download data from device:

1) Enter the "Set" menu of the device

2) Press the up and down arrow softkey to select Send data
3) Press the Set softkey to enter Send data setting

4) Press the up and down arrow softkey to select memory.
5) Press the Ok softkey

Cancel

Connected

Follows the instructions displayed, if success, the dialog will dismiss and data will be displayed.

| < IR 1200-50D - 1200 - X

Device  Graph

| f Data \ Graph "'.\

PC storage range Earliest data:  05-03-2013 16:66:25 Latest data:  03-04-2013 23:05:38
| % Summary
| All Data [ Export Excel ] [ Expart C5Y ]
Recaord Time IR (%) EMS TH (2
GATT AT s Pl || DownadLogser
03-01-2013 143300 234 0as
03-01-2013 143320 2.8 0493
03-01-2013 14:33:40 35.0 045
03-01-2013 143700 222 0as
03-01-2013 14:37:30 35.8 0493
03-01-2013 18:10:00 246 045
02-02-2013 1820000 330 0as
02-02-2013 19:20:30 33.0 043
05-02-2013 17:00:00 256 045
03-04-2013 25:10:00 252 085
03-04-2013 23:10:30 276 043
< >
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6.10.7 IR 1200-50D — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display £ Plot Data

Dizplay ¢ Plot 0 ata
() PC Starage Range Earliest data:  05-03-2013 16:56:25 Latest data; 05-03-2013 17:05:20
(+) Fram: 30032013 235220 b To: | 01-04-2013 00:52:20 b
Measurement Temperature °C v
| o || close
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 Measurement User can select which measurement unit to download.
4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.10.8

IR 1200-50D — Data View

IR 1200-50D contains one measurement (Temperature) only, its unit can be Celsius or

Fahrenheit, can be selected in Display / Plot Data dialog.

~ IR 1200-50D - 1200

Device  Graph

Graph

\

P storage range

Earliest data:  05-03-2013 16:56:25

Latest data: 05-03-2013 170320

Play

A WNBR

Export Excel
Export CSV

Download Logger

Connected

% Summary

All Data [ Expart Excel ] [ Expart C5Y ]
Recard Time IR (") Em=
05-03-2013 16:56:26 234 0.a5
05-03-2013 16:56:27 238 095
05-03-2013 16:56:29 225 0.85
05-03-2013 170912 258 0.8s
05-03-2015317:09:13 258 0.a5
05-03-201317:09:14 288 095
05-03-2013 17:09:15 281 0.85
05-03-2013 170916 281 0.8s
05-03-201317:09:17 281 0.a5
05-03-201317:09:18 251 095
05-03-2013 17:09:19 281 0.85
05-03-2013 17:09:20 280 0.8s

Export the reading to Excel (.xls) format.
Export the reading to Excel (.csv) format.

Enter the real time mode.
Download stored data in device.
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6.10.9 IR 1200-50D — Graph View

~"IR 1200-50D - 1200 - X
. Device  Graph
Data / Graph \
IR 1200-50D - 1200
[ % IR(C) TK(C) x EMS |
30 1 T T T T | T T T T T T T T T 1 1.00
9 _ — 0.99
2 T +o0.98
i 10.97
o 27 T 1
o 1 1096
S5 26 I
s I T 2]
S T J( x + 095 =
a8 25 + I w
£ T + 0.94
24 1 -
E 1093
23 1 1 0.92
22 % 1 0.91
21 1 ' : : : | ' ' : : | : : : ' | T 0.90
16:55:00 17:00:00 17:05:00 17:10:00
05-03-2013 05-03-2013 05-03-2013 05-03-2013

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.10.10 IR 1200-50D — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for IR 1200-50D is the same as Windows version, except the downloaded
data can only have 10,000 readings in a single download.
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6.11 SL451

SL451 is a data logger for storing sound level reading. SL451 support real time measurement.

6.11.1 Add new SL451

To add SL451 to Voltsoft, first connect SL451 to PC via USB port, press the "SETUP” button on
the device until the circle icon (on lower left corner) disappears. When Voltsoft detected a new
SL451 attached, the following dialog will be popped up:

Device Management System

Mew device detected, do vou want bo add it inko the syskem now?

Click “Yes”, the following dialog will be displayed:

\/ Add Hews Device

Device Seties |Data Loager

Model Number | SL4ST

Alias 51

[.-’-‘-.utu::-Deteu:t ] [ Add ] [

Enter a unique alias for this device, click “"Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.11.2 Remove SL451

To remove SL451, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.11.3 SL451 — Device Control Panel
- SL451 - 451 v X
| Device Graph
f Data \ Graph I".,
PLC storage range Earliest data: Mo, Latest data: WAA
ﬁ Surnmary
Measurement laximum “alue Winimum “alue Average Value
Sound Level dBA
Sound Level dBC
All Data Export Excel H Expaort CSY

Recoard Time Sound Level dBA

Sound Level dBC

The SL451 Device Control Panel contains the following items in menu:

AWNRH

N O

10

11

12
13
14
15
16

Device -> Settings

Device -> Stop

Device -> Download Data
Device -> Display / Plot Data

Device -> Email Alert

Device -> Calibration
Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As
Graph -> Zoom Out

Graph -> Zoom To Fit
Graph -> View All Data

This will launch the setting page of SL451.
Stop the real time data download.

Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the email alert module.
(Available in Professional version only)
Launch the calibration module.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.

Zoom out the graph to view all data.
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6.11.4 SL451 — Settings

\/ 451 - Settings {(HW ID:0006_1210170003)

Basic Settings
Logger Name 151

Fleaze change the device settings by using the
hardhware key an the device.

Sample Rate 15

Sample Paints 40000 5 [ Infinite

Alarm Settings

sound Lowe Level a0 2 lde High Level 130 5 dB
Sound Low Level 30 3 dB High Level 130 2 dB
Device connect,
[ Default ] [ Setup ] [ Cloze ]
1 Logger Name Input the unique alias for that device.
2 Sample Rate Instruct the data logger to log readings at a specific
rate.

3 Sample Points Configure the data logger sample points.
4 Infinite For real time mode only, the download will not stop

until the user stopped the download.

5 Low / High Alarm for dBA Configure the sound level (at unit dBA) for the low /
high alarm level.

6 Low / High Alarm for dBC Configure the sound level (at unit dBC) for the low /
high alarm level.

7 Default Button Load the factory default settings.
8 Setup Button Save changes.
9 Close Button Close this interface.

6.11.5 SL451 - Download Data

This module allows user to download the data from SL451, it will download the data when user
pressed the “"REC” button on the device.

Download Data

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recarding.

Device connect. ] l ’ Cancel

Click “"OK” button to stop the recording and start downloading.
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6.11.6 SL451 — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Digplay/Plot Data
(O PC Storage Range Earliest data:  M/& Latest data: Current Time

& From: 26-01-2013 173817 b Ta: | 27-01-201318:38:17 b

() Beal Time Data

Device connect.

| ok || cos= |

1 PC Storage Range Download all data stored in the database.

2 Time Range Select the data reading range.

3 Real Time Data Download real time data, will only enable if the device
in real time mode. (by press the “Setup” button in
Settings)

4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.11.7 SL451 — Data View

SL451 contains two measurements (sound level in dBA and sound level in dBC), the device can
record only one measurement at any specific unit of time (by press the “A/C” button on
device).

< SL451 - 451 - X

Device  Graph

/ Data \ Graph I'\Il

PC ztorage range Earliest data:  27-01-2013 22:68:14 Latest data:  27-01-2013 22-63:45

¥ Summary |
. All Data Export Excel ] [ Export C5Y ]

Record Time Sound Levvel dBA& Sound Lesvel dBC

27012015 2205824 213

27012013 25825 =07

27-01-2013 225826 21

27-01-2013 225827 0.7

27012013 2205825 =12

27012013 25529 =04

27-01-2013 225850 211

27-01-2013 225851 =1

27012013 225852 15

27012013 205833 a08

27-01-2013 225854 21

27-01-2013 225855 208

27-01-2013 225856 0.7

27012013 25857 a0

27-01-2013 225855 203

27-01-2013 225859 =1

27-01-2013 2255840 203

27012013 225844 a05

27-01-2013 225842 0.7

27-01-2013 225843 %04

27-01-20 44

1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.11.8
_/5L451- 451

Device  Graph

SL451 — Graph View

Data /

Graph \

SL451 -451

[ < Sound Level dBA
518 ———————

Sound Level dBC |

516 1
514 1
512 1
51.0 1

s08

Sound Level

506
504 F

502 I

t t t : | t t } t
22:58:20 2215820 22:58:40
From:27-01-2013 22:58:23 To:27-01-2013 22:58:44

225850

Our graph supports the following operations

1
2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values
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6.11.9 SL451 — Email Alert

\/ Email Alert E| |§|E|

Recipient(z] Lzt

Following receipient[z] will receive email alert

johrzmitiigmail. com

As SL451 supports real time measurement, therefore, it has an email alert feature, which will
send out an email to the specified user when the device reading is above or below a certain
level. The alert level can be configured in Setting.

User can use this module to select who will receive the email for the specific device.

6.11.10 SL451 — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for SL451 is the same as Windows version, except the downloaded data can
only have 10,000 readings in a single download.
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6.12 VC930/VC950

VC930 / VC950 are DMM devices which measure a number of different measurements.

6.12.1 Add new VC930 / VC950
When Voltsoft detected a new VC930 / VC950 attached, the following dialog will be popped up:

Device Management System

Mew device detected, do vou want bo add it inko the syskem now?

Click “Yes”, the following dialog will be displayed:

\/ Add Hew Device

Device Seties |DMM

Model Number  4C930

Alias 330

[.-’-‘-.utn:n-Detec:t ] [ Add ] [

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.12.2 Remove VC930/ VC950

To remove VC930 / VC950, go to Device Management -> Remove Existing Device and its PC
data Storage, select the device you want to remove and click the "Remove” button.
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6.12.3

VC930 / VC950 — Device Control Panel

Device  Graph

i

PC storage range

2 ¥ Summary

Data

\..

Graph

Earliest data: 15-06-2011 05:39:52

Latest data Current Time

Real Time Mode

Recard Time

16-06-2011 12:39:59
16-06-2011 12:40:00
16-06-2011 12:40:01
16-06-2011 12:40:02
16-06-2011 12:40:03
16-06-2011 12:40:04
16-06-2011 12:40:05
16-06-2011 12:40:06
16-06-2011 12:40:07
16-06-2011 12:40:08
16-06-2011 12:40:09
16-06-2011 12:40:10
16-06-2011 12:40:11
16-06-2011 12:40:12
16-06-2011 12:40:13
16-06-2011 12:40:14
16-06-2011 12:40:15
16-06-2011 12:40:16
16-06-2011 124017
16-06-2011 12:40:18
16-06-2011 12:40:19
16-06-2011 12:40:20
16-06-2011 12:40:21
16-06-2011 12:40:22
16-06-2011 12:40:23
16-06-2011 12:40:24

Reading
273
2735
273
273
2735
273
72
v
275
26
)
ry
274
)
ry
275
)
ry
275
274
274
273
vy
272
276
274

LUnit Function
s Temp.
oC Temp.
oC Temp.
s Temp.
oC Temp.
o Temp.
s Temp.
oC Temp.
o Temp.
s Temp.
oC Temp.
o Temp.
s Temp.
oC Temp.
o Temp.
s Temp.
oC Temp.
s Tetmp.
s Temp.
oC Temp.
s Tetmp.
s Temp.
oC Temp.
s Tetmp.
s Temp.
oC Temp.

[ Export Excel ] [ Export C5Y ]

| [ o

Temp.

216

The VC930 / VC950 Device Control Panel contains the following items in menu:

1 Device -> Data Record Settings

N

Device -> Download Data
3 Device -> Display / Plot Data

4 Device -> Email Alert

5 Graph -> Plot Colour

6 Graph -> Background Colour
7 Graph -> Grid

8 Graph -> Line

9 Graph -> Points Indicator

10 Graph -> Print

11 Graph -> Save Image As
12  Graph -> Zoom Out
13  Graph -> Zoom To Fit

This will launch the setting page of VC930 /
VC950.

Download reading from device.

Select the time range that the device reading
should retrieve.

This will launch the email alert module.

(Available in Professional version only)

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.12.4

VC930 / VC950 - Download Data

This module allows user to download the data from VC930 / VC950.

Dowmnload Data

{*) Download Datalog

Device dizconhect.

EEX]

) Download Storage

o [ oom ]

Click "OK” button to stop the recording and start downloading.

6.12.5

N =

N O

VC930 / VC950 — Settings
\/ 950 - Settings (HW ID:0008_00000001)
Basic Settings
Logger Mame w350
Sample Paints 40000 % [ Infinite
Sample Rate 15 |»
Alarm Settings
hWleasurernent AL (W) w
AC MW Low Level 0| High Level 1000
Device disconnect, [ Setup ] [ Cloze

Logger Name
Sample Points
Infinite

Sample Rate
Alarm Settings*

Setup Button
Close Button

Input the unique alias for that device.

Configure the data logger sample points.

For real time mode only, the download will not stop
until the user stopped the download.

Instruct the data logger to log readings at a specific
rate.

Select the measurement column and alarm level.
Save changes.

Close this interface.

* Note: The alarm can be configured in the following measurement ranges:

Unit Function Mode Unit Function Mode

\Y AC - % mA AC %
\Y DC - % mA DC %
\Y AC+DC - % mA AC+DC %
\Y AC A AC -
\Y DC A DC -
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6.12.6 VC930 / VC950 — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display f Plot Data

Dizplay / Plot Data
() PC Storage Flangs Earliest data:  N/& Latest data MNA&
(=) Fram: 2303-20131316:27 o To: | 24-03-201314:16:27 hd
Measurement AC V) w
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 Measurement User can select which measurement record to
download.
4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.12.7 VC930/ VC950 — Data View

VC930 / VC950 contains many different measurements, you will need to specify which

measurement (and unit) to download in “Display / Plot data” dialog.

Device

Graph

It

PC storage range

Data

Ealiest data:  24-03-201313:17.19

\ Graph ".\

Latest data Current Time

2 Summary

| History Data 3 [ Back to real time made [ Esnart Eagal | [ Fourort [ |

Record Time Reading Unit Function Mode # 1 Stop Record I [ Stop Display ]

24-03-2013 131719 277 my ac
24.03-201131317:21 275 my ac

|| 24.0320131317:22 275 my ac
24-03-20131317:23 2585 my ac n 5 1 ﬂ
24-03-20131317:24 2585 my ac
24.03-21131317:25 266 my ac _
24.03-20131317:26 2565 my ac
24-03-20131317:28 285 my ac
24-03-201313:17:29 265 my AC n
24.03-20131317:30 285 my ac
24-03-20131317:31 2585 my ac
24-03-20131317:32 2585 my ac
2403301313733 285 my ac 2 JiTH
24.03-2013 131734 265 my ac
24-03-20131317:36 254 my ac
24-03-20113 1314737 264 my AC
24.03-20131317:38 254 my ac
24-03-20131317:39 2565 my ac
24-03-20131317:40 286 my ac
24.03-20131317:41 266 my ac
24.03.201313:17:42 266 my ac
24-03-20131317:43 286 my ac
24-03-201313:17:44 266 my AC
24.03-20113 131746 265 my ac
24-03-201313:17:47 264 my ac
24-03-20131317:48 254 my ac
24.03-2013 131749 264 my ac mu
24.03-20131317:50 264 my ac
24-03-20131317:52 2563 my ac L
24-03-20131317:54 263 my AC
24.03-2113 131755 263 my ac
24-03-20131317:56 262 my ac
24-03-20131317:57 262 my ac
24.03-20131317:58 262 my ac
24.03-2013131800 262 my ac
24032013 131801 25652 my ac
24-03-2013 131802 252 my ac
24.03-2113 131803 261 my ac
24.03-2013 131804 251 my ac
24-03-2013 131805 251 my ac
24-03-2013 131807 260 my AC a

1

2
3

Record / Display

Button

Display Area
Back to real time

mode

Use these two buttons to toggle between display and record
mode.

In display mode, the reading measured by the device will
be displayed in the display area.

In record mode, the reading measured will not only display
in the display area, but also be stored in the database for
future use.

N.B.

i) If the device is in record mode this means it is also in
display mode.

ii) Stopping the display mode will also stop the record
mode.

Display the measured value.

This button will display when the device is in real time
mode but the interface is not showing real-time data (e.g.
downloading log data / historical data).

Clicking this button can return the interface to display real-
time data.
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6.12.8 VC930 / VC950 — Graph View

Device  Graph

Data / Graph
VC950 - 950
X AC(mV) |
280 T I T T T T T I
275 |
s 270 T
E
0 1
< 265
2.60 +
] A
255 L+ ++ -
13:117:42 13:17:46 13:17:50 13:17:54 13:17:58 13:18:02 13:18:06 13:18:10
From:24-03-2013 13:17:19 To:24-03-2013 13:18:10

Our graph supports the following operations

1 Mouse wheel

2 Mouse click and drag
3 Shift + mouse click
4 Mouse over on point

Zoom-in / Zoom-Out

Zoom-in
Pan

Display reading values
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6.12.9 VC930 / VC950 — Web Interface

Please refer to section 5.6 on how to launch the web interface.
The web interface for VC930 / VC950 is similar to the Windows version, except two points:
1. Downloaded data can only have 10,000 readings in a single download.

2. The status of the "Record” and “Display” button will not be refreshed automatically. A
“Refresh” button was therefore added, so click on the button to refresh the button status.

G850+ 850 (2
Device Graph
Data Graph
PC storage range Earliest ciata; 24-03-2013 1317:19 Latest data: 24-03-2013 121810 _
¥ Summary
[ Expont CSY ] [ Expart Excel ]
Recard Time Reading Uit Function Made | ﬁ!‘ | Start Display
0 0 0
0 -
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6.13 VC880/VC650BT

VC880 / VC650BT are DMM devices which measure a number of different measurements.

6.13.1 Add new VC880 / VC650BT

To add VC880 / VC650BT to Voltsoft, first connect the device to PC via USB port, press “REL /
PC” button on the device until the PC icon appear. When Voltsoft detected a new VC880 /

VC850 attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

Click “Yes”, the following dialog will be displayed:

\/ idd New Device

Device Series |DMM vl
Model Number  VC880 v|
Alias 280 |

[.i'-.ut-:u-Dete-:t ] [ Add l [ Cloze ]

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.13.2 Remove VC880 / VC650BT

To remove VC880 / VC850BT, go to Device Management -> Remove Existing Device and its PC
data Storage, select the device you want to remove and click the "Remove” button.
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6.13.3 VC880 / VC650BT — Device Control Panel
I Device  Graph
/ Data \' Graph
PC storage range Earliest data:  02-12-2012 13:33:13 Latest data:  0212-2012 19:38:21
¥ Summary |
Real Time Mode Back to real time mode I Expart Excel I [ Export SV ]
Recard Time Function Reading Unit Range Sub Wi [ Stop Record l l Stop Display l
02-12-201219:38:13 [slety 0.26 mh EO0 [u] Device Control
02-12-201219:35:14 DY 0.26 mh' EO0 [u]
[ Manudl Range | [ AutoRange | [ mmamivave | [ EdtMax | [ NGBesp ][ Light |
[ seect [ Hua ][ REL ] [ PassBesp | [ COMP Yalue |
[ Single Log l [ Seriez Log ]
[ Load Device Memary ] [ Clear Device Memary ]
[ Load Comparison Memary ] [ Clear Comparison Memary ]
000.21 o
L 0 1 2 3 4 3] GO0y
|
< >

The VC80 / VC650BT Device Control Panel contains the following items in menu:

1 Device -> Data Record Settings
2 Device -> Display / Plot Data

3 Device -> Email Alert

4 Graph -> Plot Colour

5 Graph -> Background Colour
6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11  Graph -> Zoom Out
12  Graph -> Zoom To Fit

This will launch the setting page of VC880 /
VC650BT.

Select the time range that the device reading
should retrieve.

This will launch the email alert module.

(Available in Professional version only)

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.13.4
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VC880 / VC650BT — Settings

\/|¥CB80 - Settings (HW ID:0009-000000000000507)

Basic Settings
Logger Narme

Sarmple Points

Sample Rate

Alarm Settings

Measurement

Lowy Level

Device dizcotnect.

/CBED)
40000

158 |»

Skip repeat reading

Function

ACHDC Y

a

3 [ Infinite

Unit Mode
v b v R, v

High Level 1000

[ Setup H Close

Logger Name
Sample Points
Infinite

Sample Rate
Skip repeat reading
Alarm Settings*

Setup Button
Close Button

Input the unique alias for that device.

Configure the data logger sample points.

For real time mode only, the download will not stop
until the user stops the download.

Instruct the data logger to log readings at a specific
rate.

System will not record a duplicate reading if this option
was checked.

Select the measurement column and alarm level.
Save changes.

Close this interface.

* Note: The alarm can be configured in the following measurement ranges:

Function Unit Mode

AC+DCV Vv N/A

AC+DCV Vv A
ACV Vv N/A
ACV Vv A
DCV Vv N/A
DCV Vv A
DCV mV N/A
DCV mV A
ACA HA N/A
ACA A N/A
ACA mA N/A
ACA HA A
ACA A A
ACA mA A

Continuity Q N/A
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Diode \Y; N/A
Duty Cycle % N/A
DCA A N/A
DCA A N/A
DCA mA N/A
DCA A A
DCA A A
DCA mA A
Capacity uF N/A
Capacity mF N/A
Capacity nF N/A
Capacity UF A
Capacity mF A
Capacity nF A
Freq Hz N/A
Freq kHz N/A
Freq MHz N/A
Impedance Q N/A
Impedance kQ N/A
Impedance MQ N/A
Temperature °C N/A
Temperature °F N/A
ACV Low-pass \Y; N/A
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6.13.5 VC880 / VC650BT — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display / Plot Data Q‘El@‘

Display / Plot Data
) PC storage 1angs Earliest data:  24-03-2013 21:26:18 Latest data: 24-03-2012 21:29:16

&) From: 23-03-2M1321:31:45 To: | 24-0320132231:45 v

Measurement
Function Unit Made

AC+DCY vl v v N/A v
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 Measurement User can select which measurement record to
download.
4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.13.6 VC880 / VC650BT — Data View

VC880 / VC650BT contains many different measurements, you will need to specify which
measurement (and unit) to download in “Display / Plot data” dialog.

Dewice  Graph

/ Data

PC storage range Earliest data:  24-03-2013 21:26:118

¥ Summary

\ Graph ".‘

Latest data:  Current Time

Back to real time mode

]

4 [ Export Excel ] [ Export C5Y ]

Record Time Functian Reading
|| 24-03-2013 21:26116  DCY 023
24-03-2013 21:26119  DCY 019
24-03-2013 21:26:20  DCY o1
24-03-2013 21:26:1 DCy 0.os
24-03-2013 21:26:22  DCY 0.0s
24-03-2013 21:26:23  DCY 012
24-03-2013 21:26:24  DCY 007
24-03-2013 21:26:25  DCY 0.08
24-03-2013 21:26:26  DCY 0.04
24-03-2013 21:26:27  DCY 0.0z
24-03-2013 21:26:26  DCY oo
24-03-2013 21:26:28  DCY oo
24-03-2013 21:26:30 DCY o

24-03-2013 21:2631 DCY
24-03-2013 21:26:32 DCY
24-03-2013 21:26:33  DCY
24-03-2013 21:26:34  DCY
24-03-2013 21:2635  DCY
24-03-2013 21:26:36  DCY
24-03-2013 212637 DCY
24-03-2013 21:26:38  DCY
24-03-2013 21:26:39  DCY
24-03-2013 21:26:40 DCY
24-03-2013 21:26:41  DCY
24-03-2013 21:26:42  DCY
24-03-2013 21:26:43  DCY
24-03-2013 21:26:44  DCY
24-03-2013 21:26:45  DCY
24-03-2013 212646 DCY
24-03-2013 21:26:47  DCY
24-03-2013 21:26:48  DCY
24-03-2013 21:26:43  DCY
24-03-2013 21:26:50  DCY
24-03-2013 21:26:51  DCY
24-03-2013 21:26:52  DCY
24-03-2013 21:26:53  DCY

coooCocOoCoOoO0OCOoOCOoOOOoOOCOoOOOO

24-03-2013 21:26:54  DCY 012
24-03-2013 21:26:55  DCY 002
24-03-2013 21:26:56  DCY 0.06
24-03-2013 21:26:57  DCY 013
M NTAMMOIEER OO nin

1 Record / Display
Button

N

Command Button
3 Display Area

4 Back to real time
mode

Uit
m
m
my
m
m
my
mh
m
m
my
m
my
my
m
m
m
my
my
m
m
my
my
m
my
mh
m
m
my
my
m
my
mb
m
m
my
m
m
my
mh
m

L]

Range
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
ann

Sub Value | Mode A

e 1 Stop Record Stop Display
evice Lontro

[ MenualRange | [ AutoRange | [ mmamineve | [ Exitwax |
[ seleet  J[ Hom ] REL |

[ Single Log ] [ Series Log ]

I Load Device Memany H Clear Device Memomn ] 2

1,

-000.05

Manual 400

mV

0 10 20 30 40

Use these two buttons to toggle between display and record
mode.

In display mode, the reading measured by the device will
be displayed in the display area.

In record mode, the reading measured will not only display
in the display area, but also be stored in the database for
future use.

N.B.

i) If the device is in record mode this means it is also in
display mode.

ii) Stopping the display mode will also stop the record
mode.

Refer to below section.

Display the measured value.

This button will display when the device is in real time
mode but the interface is not showing real-time data (e.g.
downloading log data / historical data).

Clicking this button can return the interface to displaying
real-time data.
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Command Button
Manual Range
Auto Range
MAX / MIN / AVG
Exit Max
NG Beep
Light
Select
Hold
REL
Pass Beep
COMP Value
COMP Setting
Single Log

Series Log

Load Comparison Memory

Clear Comparison Memory

Load Device Memory

Clear Device Memory

Data Comparison dialog

Click to send commands to make device entering the
manual range.

Click to send commands to make device entering the
auto range.

Click to send commands to enable maximum, minimum,
average function.

Click to send commands to exit maximum, minimum,
average function.

In the COMP VALUE mode, if failed, click button to turn
the alarm on/off.

Click to send commands to enable device backlight
function, and then click the exit functions.

Click to send commands to enable device function
selection.

Click to send commands to enable device to maintain the
function, and then click to exit maintain function.

Click to send commands to enable the relative value
function; then click to exit the function.

In the COMP VALUE mode, if passed, click button to turn
the alarm on/off.

Enter / Leave COMP value mode.

Pop up Data Comparison dialog.

Click to send commands to enable device to store a
single data.

Click to send commands to enable device to continuously
store data, and then click to exit the function.

Click to send commands to send out the comparison data
stored by device.

Clear the comparison data in device.

Click to send commands to send out the no comparison
data stored by device.

Clear the no comparison data in device.

High Limit
Lo Lirnit

Innet f Outer

Close

Setup Erter

s
HighLimit %0022 3 [
L Limit ooz %
Inner { Quter Inner v 0
: e

Setup Enter : When button is pressed, the upper/lower limit and the mode can be modified;
when button is up, the settings will be sent and saved in the device.
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6.13.7 VC880 / VC650BT — Graph View
i Data / Graph \
VC880 - 880
05 : : :
04 T
0.3
0.2
z
o 0.1
(& ]
0.0
-01
-0.2
-0.3 I f } } } } } } } } } } } .
21:26:00 21:27:00 21:28:00 21:29:00 21:30:00
24-03-2013 24-03-2013 24-03-2013 24-03-2013 24-03-2013
Time

Our graph supports the following operations

1
2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values
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6.13.8 VC880 / VC650BT — Web Interface

Please refer to section 5.6 on how to launch the web interface.
The web interface for VC880 / VC650BT is the similar to Windows version, except two points:
1. Downloaded data can only have 10,000 readings in a single download.

2. The status of the “Record” and “Display” button will not be refreshed automatically. A
“Refresh” button was therefore added, so click on the button to refresh the button

status.
YCBED - 880 [ |
Devica  Graph
Data Graph
PC storage range Earliest data; 24-03-2013 21:26:18 Latest dats: 24-03-2013 21:29:16
¥ Summary
[ Expaont C3Y ] [ Export Excel ]
Record Time Function Reading Uni _ Start Record Start Display
Corrmand Key
[ ManualRange | [ Auto Range | [ mMaxmtibave | | Exit Max | [ NG Beep il Light ]
[ Select il Hold il REL J[ PasBesp  |[ COMPvalue | [ COMP Setting |
[ Single Log [ Series Log |[[ Lead Comparison Memory ][ Load Device Memory |
[[clearcomparisan Memory ][ Clear Device Memory |
MEN - -
Auto
< >
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6.14 VC890

VC890 is a DMM device which measures a number of different measurements.

6.14.1 Add new VC890

To add VC890 to Voltsoft, first connect the device to PC via USB port, press “"REL / PC” button
on the device until the PC icon appears. When Voltsoft detected a new VC890 attached, the

following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it into the svstem now?

Click “Yes”, the following dialog will be displayed:

\/ Add New Device

Device Series | DMM v|
Wodel Nurmber | VCE30 v/
Alias 830 |

[Auto-Detect ] [ Add ] [ Cloze ]

Enter a unique alias for this device, click "Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.14.2 Remove VC890

To remove VC890, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.14.3 VC890 — Device Control Panel
Device  tGraph
/ Data \ ‘.\
PC storage range Eailiest data:  24-03-2013 22:02:05 Latest data:  Current Time
I % Summary
Real Time Mode [ Export Excel ] [ Expart CSY ]
Record Time Function Reading | Unit Range  Sub Yalue [ Stop Recard ] [ Stop Displap l
24-03-2013 220205 DCY 045 my E00 - Device Control
24-03-2013 2202068 DCY 0.48 my B00
24.03-2013 220207 DOV 045 m BO0 [ Manual Range ] [ Auto Range ] [ MAMINAY G ] [ Exit Max ] [ NG Beep ] [ Pass Beep ]
24-03-2013 220208 DCY 045 my B00 -
T G i s ( | ned  J[ meL ][ gt [ COMPVaue | [ COMPSeting |
24-03-2013 220211 DCY 0.45 m 600 -
24032013 220212 DCY 045 mv  BO0 [ Single Log ] [ Seiies Log ]
24-03-2013 220213 DCYV 0435 my &00
24.03-2013 220215 DOV 045 my 500 [ Load Device Memary ] [ Clear Device Memary ]
24-03-2013 220216 DCY 0.44 my GO0
24.03.2013 220217 DCV 0.45 my 600 [ Load Comparizon Memory ] [ Clear Comparizon Memory ]
24-03-2013 220218 DCY 0.44 my EO0
24-03-2013 220221 DCY 0.44 mi 600
24-03-2013 220223 DCY 043 my GO0
24-03-2013 220224 DCY 0.44 my E00
24-03-2013 22:0225 DCV 043 my EO0
24-03-2013 220226  DCY 043 my GO0
24-03-2013 220227 DCY 043 my &00
24-03-2013 220228 DCY 043 my EO0
24-03-2013 220230 DCY 0.42 m 600
24-03-2013 22:0251 Dcy 043 my GO0
24-03-2013 220232 DOV 042 my B00
24-03-2013 220233 DOV 043 my E00
24-03-2013 220234 DCY 043 my GO0
24-03-2013 220235 DCY 042 my E00
24-03-2013 220237 DOV 042 my EO0 3 I I I
24-03-2013 220238 DCY 0.42 my E00 -
24-03-2013 220238 DCY 043 my GO0 0 1 2 3 4 5 BOOMY
24-03-2013 220241 DCw 042 my E00 ¥
24-03-2013 220242  DCV 042 my EO0 !
24-03-2013 220243 DCY 041 my GO0
24-03-2013 220244 DCY 042 my &00
24-03-2013 220245 DCYV o4 my BO0
24-03-2013 220246 DCYV 0.42 my B00
24-03-2013 220245  DCY o4 my GO0
24-03-2013 220248 DCY o4 my B00
24-03-2013 220250 DOV 04 my EO0

The VC890 Device Control Panel contains the following items in menu:

N~

10
11
12
13

Device -> Data Record Settings
Device -> Device Settings
Device -> Display / Plot Data

Device -> Email Alert

Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of VC890.
Launch extra setting page of VC890.

Select the time range that the device reading
should retrieve.

This will launch the email alert module.

(Available in Professional version only)

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.14.4
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6
7
8

VC890 — Settings

'\/ VCBBO - Settings (HW 1D:0009-000000000000507)

Basic Settings
Lagger Name

Sarmple Points

Sample Rate

Alarm Settings

Measurememnt

Lowe Level

Device dizconnect,

[/C550)
40000

15

Skip repeat reading

Function

ACHDEC Y

1]

5 [ Infinite

LInit Mode
A W b T, b4

High Level 1000

[ Setup l[ Cloze

Logger Name
Sample Points
Infinite

Sample Rate
Skip repeat reading
Alarm Settings*

Setup Button
Close Button

Input the unique alias for that device.

Configure the data logger sample points.

For real time mode only, the download will not stop
until the user stopped the download.

Instruct the data logger to log readings at a specific
rate.

System will not record a duplicate reading if this option
was checked.

Select the measurement column and alarm level.
Save changes.

Close this interface.

* Note: The alarm can be configured in the following measurement ranges:

Function Unit Mode

AC+DCV Vv N/A

AC+DCV Vv A
ACV Vv N/A
ACV Vv A
DCV Vv N/A
DCV Vv A
DCV mV N/A
DCV mV A
ACA MA N/A
ACA A N/A
ACA mA N/A
ACA HA A
ACA A A
ACA mA A

Continuity Q N/A
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Diode \Y; N/A
Duty Cycle % N/A
DCA A N/A
DCA A N/A
DCA mA N/A
DCA A A
DCA A A
DCA mA A
Capacity uF N/A
Capacity mF N/A
Capacity nF N/A
Capacity UF A
Capacity mF A
Capacity nF A
Freq Hz N/A
Freq kHz N/A
Freq MHz N/A
Impedance Q N/A
Impedance kQ N/A
Impedance MQ N/A
Temperature °C N/A
Temperature °F N/A
ACV Low-pass \Y; N/A
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6.14.5 VC890 — Device Setting

Extra settings are available for VC890, the user can launch them via Device -> Device Setting.

\/ Device Setting

I1me
1
05-01-201314:11:57 % | Llse Systemn Time [ Set
Cther Setting
Battery +1 Alkaline (1 Li-Akky (Lithium battery 2
Logoer Memory (%) Fix ) Owerwrite 3
Lagger data display (*) Activate () Deactivate 4
Auto brightness (*) Activate () Deactivate 5
Logger sampling rate 15 b 6
Auta Power Off (%) A mins (3 18 mins 7
() 30 mins ) Mever
Set
Device connect.
1 Time Configure the device date time value.
The user can specify a defined time or use the system
date time.
2 Battery Configure the device current using Alkaline or Lithium
battery.
3 Logger Memory Configure logger memory to be fixed or overwritten
when full.
4 Logger data display Configure the battery saving mode to activate or not
during data logging.
5 Auto brightness Configure the battery saving mode to activate or not
during normal operation.
6 Logger sample rate Configure logger sample rate.
7 Auto Power Off Configure the auto power option
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6.14.6 VC890 - Download Data

This module allows user to download the storage data from VC890.

Download Data Q@@

The data will be downloaded from the device.
Hirt: After downloading, the device will stop recording.

Device connect. k. ] ’ Cancel

Click “OK” button to stop the recording and start downloading.

6.14.7 VC890 — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display / Plot Data Q\El@\

Display / Plot Data
) PC storage 1angs Earliest data:  24-03-2013 21:26:18 Latest data: 24-03-2012 21:29:16

&) From: 23-03-2M1321:31:45 To: | 24-0320132231:45 v

Measurement

Function Unit fode
AC+DCY v W v M/ v
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 Measurement User can select which measurement record to
download.
4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.14.8 VC890 — Data View

VC890 contains many different measurements, you will need to specify which measurement
(and unit) to download in “Display / Plot data” dialog.

Device  Graph

/ Data \ Graph “.\

PC storage range Earliest data:  24-03-2013 22:02.05 Latest data:  Current Time
¥ Summary
Back to real time mode ] 4 [ Export Excel ] [ Export C5W ]
Record Time Function Reading | Unit Range Sut A [ Stop Record I ’ Stop Display ]
24-03-2013 220205 Dy 0.45 my 00 Device Control 1
24-03-2013 22:02:06 DY 046 my' 600
24.05-2013 220207 DOV 0.45 my B0 l I anuial A ange J I Auto Range H A IR G H Exit htax I { NG Beep ] I Pass Beep ]
24-03-2013 220209 Dy 0.45 my 00
24030013 220210 DOV 045 o0 [ ek J[  Haua | meL ][ udowt ][ cOMPVaue | [ COMP Seting |
24-03-2013 220211 DY 045 my' 800
24-03-2013 220212 DCY 045 my 600 [ Single Log ] [ Series Log ]
24-03-2013 220213 Dy 0.45 my 00
24.03-2013 220215 DOW 045 e 500 [ Load Device btemory ][ Clear Device Memory ] 2
24.03-2013 220216 Dy 0.44 my' 00 - -
24032013 220217 DOV 0.45 .y 500 [ Load Comparizon bemary ][ Clear Comparizon Memary ]
24-03-2013 22:0219 Dy 0.44 i 00
24.03-2013 220221 DY 044 my' 00
24.03-2013 2220223 Dy 0.43 my 600
24-03-2013 220224 Dy 0.44 my 00
24-03-2013 22:02:25 DCy 043 mh 600
24.03-2013 220226 Dy 0.43 my' 00
24-03-2013 220227 Dy 0.43 my 00 3
24.03-2013 22:02:29 DCh 043 i 00
24-03-2013 220230 DY 042 my' 00
24.03-2013 220231 Dy 0.43 my 00
24-03-2013 220232 Dy 0.42 my 00
24-03-2013 220233 DOV 043 my 600 [B] 9
24.03.201322:02:34 Doy 0.43 mi 500 OOO 20
e e S . m\
24-03-2013 220238 DY 042 my' 00
24.03-2013 220239 Dy 0.43 my 600 - U 1 2 3 4 5 ESOOm\/
24-03-2013 220241 Dy 0.42 my 00
24-03-2013 22:02:42 DCy 0.42 mh 600 I
24.03-2013 220243 Dy 0.4 my' 00
24-03-2013 220244 Dy 0.42 my 600
24-03-2013 22:02:45 DCh 0 i 00
24-03-2013 220246 DY 042 my' 600
1 Record / Display Use these two buttons to toggle between display and record
Button mode.
In display mode, the reading measured by the device will
be displayed in the display area.
In record mode, the reading measured will not only display
in the display area, but also be stored in the database for
future use.
N.B.
i) If the device is in record mode this means it is also in
display mode.
ii) Stopping the display mode will also stop the record
mode.
2 Command Button Refer to below section.
3 Display Area Display the measured value.
4 Back to real time This button will be displayed when the device is in real time
mode mode but the interface is not showing real-time data (e.g.

downloading log data / historical data).

Clicking this button can return the interface to displaying
real-time data.

Command Button

Manual Range Click to send commands to make device entering the
manual range.
Auto Range Click to send commands to make device entering the
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MAX / MIN / AVG
Exit Max

NG Beep
Light

Select

Hold

REL

Pass Beep
COMP Value
COMP Setting
Single Log

Series Log

Load Comparison Memory

Clear Comparison Memory
Load Device Memory

Clear Device Memory

Data Comparison dialog

auto range.

Click to send commands to enable maximum, minimum,
average function.

Click to send commands to exit maximum, minimum,
average function.

In the COMP VALUE mode, if failed, click button to turn
the alarm on/off.

Click to send commands to enable device backlight
function, and then click the exit functions.

Click to send commands to enable device function
selection.

Click to send commands to enable device to maintain the
function, and then click to exit maintain function.

Click to send commands to enable the relative value
function; then click to exit the function.

In the COMP VALUE mode, if passed, click button to turn
the alarm on/off.

Enter / Leave COMP value mode.

Pop up Data Comparison dialog.

Click to send commands to enable device to store a
single data.

Click to send commands to enable device to continuously
store data, and then click to exit the function.

Click to send commands to send out the comparison data
stored by device.

Clear the comparison data in device.

Click to send commands to send out the no comparison
data stored by device.

Clear the no comparison data in device.

High Lirniit 100

Loy Limit 0

Innerf Outer Cluter A Setup Enter

L

4

Setup Enter : When button is pressed, the settings will be sent and saved in the device.
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6.14.9 VC890 — Graph View
[ Device  @raph
Data Graph \
VC890 - 890
0.50
0.45 —
0.40 —
= 0.35 f
E 3
8 030 1
0.25 —
0.20 f
0.15 + = i % = = = i
22:01:00 22:06:00 22:11:00
24-03-2013 24-03-2013 24-03-2013
Time

Our graph supports the following operations

1

2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values
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6.14.10 VC890 — Web Interface

Please refer to section 5.6 on how to launch the web interface.
The web interface for VC890 is similar to Windows version, except two points:
1. Downloaded data can only have 10,000 readings in a single download.

2. The status of the "Record” and “Display” button will not be refreshed automatically. A
“Refresh” button was therefore added, so click on the button to refresh the button

status.
vG890-880 (1|
Device Graph
Data Graph
PC storage range Eariiest data: 24-03-2013 22:02.05 Latest dala: 24-03-2013 22:14:12
¥ Summary
Export CSV Export Excel
Record Time Function Reading Unit Range Sub Vz _ Siart Record || Start Display
Command Key
‘ Msanual Range || Auto Ranga H MAXWMINAYG H Exit Max H NG Basp H Fass Baap |
‘ Seleat || Hold H REL H Light H COMP Vslus H COMP Satting |
Single Log ‘Series Log
Losd Device Memory Claar Device Memory
Load Comparison Memory || Glear Gomparison Memory
o)
L
LO
Auto -
< >
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6.15 EL4000

EL4000 is a data logger which measures the power consumption of different electronic devices.

6.15.1 Add new EL4000

As EL4000 will not be physically connected to computer, therefore, to create a new EL4000 in
Voltsoft, user is required to select Device Management->Add New Device in menu.

\/ Add New Device M=l

Device Series | EL4000

Model Mumber | EL4000

Alias EL4000

Auto-Detect [ Add ] [

Select “"EL4000” in device series, "EL4000” in model number, enter a unique device alias and
click the “Add” button.

6.15.2 Remove EL4000

To remove EL4000, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the "Remove” button.
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6.15.3 EL4000 — Device Control Panel

Device  Graph

/ Data \ I

PC storage range Earliest data:  05-09-2012 10:37-00 Latest data: 10-10-2012 20:40:00

% Summary

All Data Export Excel l [ Euport C5W

Record Time Current [4&) Active Povwer (W) Apparent Power (4 s

05-09-2012 10:37:00 2253 ] ]

05-09-2012 10:3800 2358 ] ]

05-08-201 2 10:39:00 2.255 ] ]

05-09-2012 10:40:00 57 54 ] ]

05-09-2012 10:41:00 3082 355 4163 711 5338

05-09-2012 10:42:00 i ] ]

05-08-2012 10:43:00 i ] ]

05-09-2012 10:44:00 i ] ]

05-09-2012 10:45:00 i ] ]

05-08-201 2 10:46:00 i ] ]

05-09-2012 10:47:00 i ] ]

05-09-201 2 10:48:00 i ] ]

05-089-2012 10:49:00 i ] ]

05-08-2012 10:50:00 0.009 0.303885 20259

05-09-2012 10:51:00 i ] ]

05-09-2012 10:52:00 0.m 0.3375 225

05-09-2012 10:53:00 0.008 0.234104 18008

05-09-2012 10:54:00 0.004 0.063 09

05-09-2012 10:55:00 0.006 0121608 13512

05-09-2012 10:56:00 0.006 0121662 13518

05-08-2012 10:57:00 i ] ]

05-09-2012 10:58:00 i ] ]

05-09-2012 10:55:00 i ] ]

05-08-2012 11:00:00 i ] ]

05-09-2012 11:01:00 i ] ]

05-09-2012 11:02:00 i ] ]

05-09-2012 11:03:00 i ] ] v

The EL4000 Device Control Panel contains the following items in menu:

1 Device -> Settings This will launch the setting page of EL4000.

2 Device -> Download Data Download reading from device.

3 Device -> Display / Plot Data Select the time range that the device reading
should retrieve.

4 Graph -> Plot Colour This will launch the Plot Colour module to change
the colour of the individual lines.

5 Graph -> Background Colour Change the background colour of the graph to
either black or white.

6 Graph -> Grid Control whether to show / hide the grid on the
graph area.

7 Graph -> Line Control whether to show / hide the line on the
graph area.

8 Graph -> Points Indicator Control whether to show / hide the points
indicator.

9 Graph -> Print Prints the generated chart.

10 Graph -> Save Image As Save the image in the chosen file format.

11  Graph -> Zoom Out Zoom out one level.

12  Graph -> Zoom To Fit Undo all zoom in and out.
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6.15.4 EL4000 — Settings

\/|Setting
Basic Settings
Time Use System Time
Date Format: & ddimmdyyyy ) mmdddfyyyy
Tirme Format: (%) 24-hour ) 12-hour
Logger Mame 4000
Lagger 1D 0 b
Currency Pound b
Tariff1 0.00
Tariff2 0.00
[ Drefault ] [ Save ] [ Setup ] [ Cloze ]

1 Time

2 Date Format
3 Time Format
4 Logger Name
5 Logger ID

6 Currency

7 Tariff 1

8 Tariff 2

9 Default

10 Save Button

11 Setup Button
12 Close Button

Configure the device data time value.

The user can specify a defined time or use the system
date time.

Select either dd/mm/yyyy or mm/dd/yyyy
Select either 24 / 12 hour format.

Input the unique alias for that device.

Select logger ID, from 0 - 9.

Select the currency, for calculation.

Price for Period 1

Price for Period 2

Restore the default value

Save setting changes

Save changes and export the configuration file.
Close this interface.
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6.15.5 EL4000 - Download Data

This module allows user to download the storage data from EL4000.

Download Data

Browsze the location of data files:

"

To download data, click “...”, select the location of data files, and then click the “Download”
button to start downloading.

Please note that the logger ID of the data file must be the same of the logger ID configured in
setting, otherwise download will not be allowed.

6.15.6 EL4000 — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

[hzplay/Plot D ata
() PC storage range Earliest data;  WAA Latest data: MAA

(=) From: 09-12-2012 16:22:34 b To: (10122012 17.22:34 bt

Device connect.

| ow || cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.15.7 EL4000 — Data View

EL4000 contains three measurements (Current, Active Power and Apparent Power),

Device  Graph

f Data \ ;

PC storage range Earliest data:  05-09-2012 10:37:00 Latest data:  10-10-2012 20:40:00

% Summary

All Data Expart Excel l [ Ewpart C5W

Record Time current (2 Active Power (W) Apparent Power (A4 -

05-08-2012 10:37:.00 2253 1] 1]

05-05-2012 10:35:.00 2255 o o

05-09-201 2 10:39:00 2.255 0 0

05-08-2012 10:40:00 57 54 1] 1]

05-08-2012 10:41:00 3.082 3555169 7116335

05-09-2012 10:42:00 u} 0 0

05-08-2012 10:45:00 ] ] ]

05-08-2012 10:44:.00 a 1] 1]

05-05-2012 10:45:.00 a o o

05-09-201 2 10:46:00 u} 0 0

05-08-2012 10:47:.00 a 1] 1]

05-08-2012 10:45:00 a 1] 1]

05-09-201 2 10:49:00 u} 0 0

05-09-2012 10:50:00 0.009 0.303885 2.0259

05-08-2012 10:51:00 a 1] 1]

05-08-2012 10:52:00 0.0 0.3375 225

05-09-201 2 10:53:00 0.005 0.234104 15005

05-08-2012 10:54:00 0.004 0.055 o8

05-08-2012 10:55:00 0.005 0121605 13535912

05-03-201 2 10:56:00 0.008 0121662 1.3518

05-09-2012 10:57:00 0 0 0

05-08-2012 10:55:00 a 1] 1]

05-08-2012 10:59:00 a o o

05-09-2012 11:00:00 u} 0 0

05-08-2012 11:01:00 ] ] ]

05-08-2012 11:02:00 a 1] 1]

05-08-2012 11:05:.00 a o o '
1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.15.8 EL4000 — Graph View
. Device  Graph
f"l Data }( Graph \
EL4000 - EL4000 Calculate
[ = Current . Active Power x Apparent Power |
| 800 y y T T T E E E T T E E T E T y T T T T T T 70
700 4 10
| BOO + I
+ &0
s00 L
g +40 g
5 400 1 5
2] -
e ] 13 &
300+ L
1o
200 4 r
100 | e
o 4 L 0
00:00:00 00:00:00 00:00:00 00:00:00 00:00:00 00:00:00 00:00:00
01092012 08-09-2012 15-09-2012 22092012 29-09-2012 05-10-2012 13-10-2012

Our graph supports the following operations

1 Mouse wheel

2 Mouse click and drag
3 Shift + mouse click
4 Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values
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6.15.9

EL4000 — Calculate

User can calculate the price for power consumption by using this module.

1 From / To
2 Price 1 / Price 2

\/ Calculation

Price Settings Feszults
From 1 Consumption:
05-09-2012 10:37 b Cast
To
10-10-2012 20:40 v Farcast
Monthly
FPrice 1 Consumption:
. . - 2
From: | 03:00 S Cisk
T 19:59 3 Yearly
Price:(£ ] |0.100 Awih Ees gl
Price 2 Cost:
Fromm:
To:
Price:[# ] |0.200 b
i Calculate |

1342 Iwh

£1.96

11.369 kwh

£ 1.66

138,323 Kwh

£ 2017

Cloze

Click the “Calculate” button to calculate the price.

6.15.10

EL4000 —Web Interface

Define the record period
Unit price for different time period

Please refer to section 5.6 on how to launch the web interface.

The web interface for EL4000 is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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7 Auto Upgrade

Voltsoft will perform version checking every time when it starts up, and if there is a new
version available, the following dialog box will be displayed:

Yoltsoft System Upgrade |5

Mew Yersion Found!
Do ol wish ko update at this bime?

ifes | [ Mo

User can click “Yes” to perform an upgrade or “No” to skip the upgrade. In order to enjoy the
new features of Voltsoft, it is highly recommended to perform the upgrade.

System Updater,

Downloading latest application...

[ L1 1))

The system will continue to launch once the upgrade is completed.
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8 Appendix
8.1 Real-Time device list

Only the following devices will have real-time features:

Family Model Number
Data Logger DL161S
SL400
DMM VC 930 / VC950
DMM VC 880 / VC650BT / VC890

Remarks: The speed of data logging (i.e. sample rate) much depends on the capacity of your
computer and its performance will be affected when 2 or more sets of real-time devices are
running at the same time.

8.2 Internet Explorer 10

Current version of Voltsoft web version do not support Internet Explorer 10 (I.E. 10), to access
Voltsoft by I.E. 10, please select “Tools"->"F12 developer tools” in user menu, then select
“Internet Explorer 9” for Browser Mode.

File Edit View Favourites Help
Delete browsing history... Ctrl+5Shift+Del
InPrivate Browsing Ctrl+Shift+P

Tracking Protection...
ActiveX Filtering

Fix connection problems...
Reopen last browsing session

Add site to Start Screen

View downloads Ctrl+J
Pop-up Blocker »
SmartScreen Filter b

Manage add-ons
Compatibility View
Compatibility View settings
Subscribe to this feed...

Feed discovery 3
Windows Update

F12 developer tools

Internet options
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C55  Console Script  Profiler Metwork

b R E 4 B HE

File Find Disable View Images Cache Tools Validate |Document Mode: IE7 standards

Internet Explorer 10
Internet Explorer10 Compatibility View

po<d-- DOCTYPE html PUBLIC "-//W3C//DTD XHTHML 1
B~ <html xmlns="http://www.w3.org/1999/xhtml">

E Internet Explorer 9
Internet Explorer 8
Internet Explorer 7

Search HTML... 2]

yout  Attributes
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